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1. Allgemeines 
 
1.1 Neue PC-Crash-Version installieren 
 
Empfohlen: 
>Datei > Grundeinstellungen…: Pfade anpassen 
„Verzeichnis automatisch aktualisieren“: deaktivieren 
 
Button „Anzeigeoptionen: 

 
 
 
1.2 Ablagedatei Sicherungskopie 
 
Ist gespeichert unter (aktuell bei mir):      C:\Users\servi\AppData\Local\Temp\Recover_C140.PRO  
Beim Beenden von PC-Crash wird diese Datei gelöscht 
 
1.3 Fotos EES-Katalog AZT und Autoexpert im EES-Katalog und im 
Stoßfenster aktivieren 
 
Fahrzeug > EES-Katalog > Einstellungen: installierte Datenbanken anklicken und 
Pfad für Fotos zusätzlich zum bestehenden Pfad eingeben C:\Programme\Autoexpert\... 
 

 
1.4 Vorschaubilder beim Laden der Fahrzeuge aus Kfz-Datenbank fehlen 
 
Nach einer vorangegangenen Installation von PC-Crash in einem anderen Ordner ist der Pfad in der Registry 
falsch gesetzt. Zur Behebung:  Start > Ausführen >  

„Rückgängig“: aus 
„automatische Speicherung“: aus 
(Programmabstürze werden 
vermieden) 



 

 

regedit > HKEY_Current_User > Software > DSD > PC-Crash8.3 > Directories > dbpreview 
Die Zeile „dbpreview“ und ggf. „dbpreview2“ usw. löschen, PC-Crash neu starten 
 
 
1.5 Eigene Fahrzeugdaten als Vorlage speichern, z. B. Lkw, Abschleppstange 
 
Datei > exportieren > Fahrzeugdaten >  

    
 
Gleiche Vorgehensweise bei MKS, Dateityp Mehrkörpersystem (*.mbdef) auswählen. 
 
 
1.6 Eigene dxf speichern 
 

   
 
 

1.7 Eigene Projektvorlagen erstellen 
 
 Fahrbahn laden 
 Fahrzeuge laden 
 Kinematik-Toolbar ausfüllen 
 
Unter PCCrashXX > Templates: 
Als Projektvorlage *.pct abspeichern 
 
Es kann auch ein Projekt *.pro in eine Vorlage *.pct umbenannt werden 
 
  

Fahrzeug-Nr. auswählen 

Bezeichnung „Fahrer“ löschen 

Speicherort auswählen 

Dateityp auswählen (*.dat) 

„Speichern“ 

Hinweis: 

*.dat = altes Format 

*.xml = neues Format 

dxf öffnen (bearbeiten), alles markieren 
 
Datei > DXF Zeichnung (=Objekt) mit 
diesem Button (in eigene Datei) speichern 



 

 

1.8 Grundeinstellungen 
 
Automatisches Erstellen von Ordnern ausschalten: 
 
Datei > Grundeinstellungen 
 

 

 
 
„Bitmaps in Projektdatei speichern“ und „DirectX Objekte, Bitmaps in Projektverzeichnis speichern“ wegklicken 
 
 
Ribbon: 
 
Ab der PC-Crash-Version 11.0 können Ribbons analog dem aktuellen MS-Office-Paket verwendet werden. 
Der Vorteil ist, dass deutlich weniger Symbole angezeigt werden, somit mehr Platz als Arbeitsoberfläche zur 
Verfügung steht.  
 
Bei einer Änderung der Bildschirm-Auflösung, z. B. bei der Verwendung eines Beamers, bleiben die Ribbons 
erhalten. Wenn die herkömmlichen Symbolleisten verwendet werden, verkürzen sich diese, so dass einzelne 
Symbole zunächst nicht mehr auffindbar sind und erst aufgeklappt werden müssen. 
 
Häufig verwendete Symbole können oberhalb der Ribbons abgelegt werden („Schnellzugriffsleiste“). Durch 
einen Klick mit der rechten Maustaste auf ein Symbol kann dieses direkt zur Schnellzugriffsleiste hinzugefügt 
werden. 
 
 
Die Ribbon-Anordnung kann auf andere PC´s übertragen werden:  rechte Maustaste in Kopfzeile (blauer 
Bereich) \ Symbolleiste für den Schnellzugriff anpassen \ Menüband anpassen > Importieren/Exportieren > 
„Alle Anpassungen exportieren“, dann im anderen PC importieren 
 
 
 
 
  



 

 

1.9 Anhalts- / Richtwerte / Tipps 
 
Leergewicht: 
Laut EG-Richtlinie ab Erstzulassung 1.1.1993: 

- inkl. Fahrer mit 68 kg 
- inkl. Gepäck 7 kg 
- inkl. 90 % Tankfüllung 

 
Vorher: ohne Fahrer, ohne Gepäck, ca. 10 l Kraftstoff (Reservetankfüllung) 
 
Bei Lkw und KOM: tatsächliches Gewicht eingeben, nicht über Beladung 
 
Rollwiderstand: 
Gemessen auf Beton-Fahrbahn im Tankstellengelände   0,1 m/s2 
 
Verzögerungswirkung im Erdreich: 
Schramme im Asphalt durch LM-Felge: µ = 1 – 1,5 
Achse gräbt sich ins Erdreich ein: µ = 3 (…4) 
 
 
Schwerpunkthöhen: 
BMW ca. 0,55 m 
BMW Z3 ca. 0,50 m 
Ford Galaxy ca. 0,60 m 
Ford Maverick ca. 0,67 m 
Toyota Land Cruiser ca. 0.84 m 
MB G-Klasse ca. 0,65 m 
Twingo, Polo ca. 0.50 m 
Passat ca. 0.55 m 
Traktor ca. 0.90 m 
 
MB Vito 112 CDI, Kombi bestuhlt, Radstand 3.000 mm ................................... 742 mm 
Opel Vivaro 1,9 DTi, Kasten, Trennwand, Radstand 3.103 mm ....................... 721 mm 
MB Sprinter 313 CDI, Kasten Hochdach, Trennwand, Radstand 3550 mm ..... 836 mm 
MB Sprinter 313 CDI, Kombi Hochdach, bestuhlt, Radstand 3550 mm ........... 875 mm 
Opel Movano 2,5 DTI, Kasten Hochdach, Trennwand, Radstand 3578 mm .... 831 mm 
FORD Transit 3,2t, Kasten mittl. Dach, Trennwand, Radstand 3750 mm ........ 782 mm 
 
Werte im Leerzustand gemessen, Werte sind abhängig von Ausstattungen, Motor, Beladung usw.  
Siehe auch colliseum.net 
 
Schwerpunkt-Höhe hS nach Uwe Fürbeth (VKU, 03/2016, S. 97): 
 
hS = 0,436158 * hD – 0,0864623 ;  hD = Dachhöhe, Höhe Fahrzeug ohne Dachreling 
 
 
Luftwiderstand: 
cw Pkw ca. 0,25 bis 0,35 
cw Planenanhänger seitlich ca. 1,0 (Plane wird nach innen gedrückt, konkav) 
 
 
ESP: 
20 - 100 Hz ergibt Zykluszeit 0.05 bis 0.01 s 
Schwellwert 0,1 rad/s entspricht ca. 5° Abweichung 
Eingriffsfaktor:    Pkw ca. 0,6 (= 60 % Abbremsung maximal) 
                           Lkw bis ca. 1 
 
bei Schwellwert 0,05 wird Fahrzeug stabiler 



 

 

bei Eingriffsfaktor 1,0 wird Fahrzeug deutlich stabiler 
 
Kontaktreibung, z. B. an Mauer oder Leitplanke, reduzieren: 
 

  
 
 
Auffahrunfall / Heckkollision: 
Ab einem Δ v von ca. 8 – 10 km/h kann der Fuß nicht mehr auf das Bremspedal gedrückt werden, Bremse 
bleibt dann ca. 0,5 bis 0,8 s gelöst 
 
 
Reibung: 
z. B. Rutschen Krad auf trockener FB, ohne Verkleidung  = 0,35 bis 0,5 , mit Verkleidung  = 0,3 bis 0,4 
 
 
Blockiertes Rad: 
Aus 80 km/h auf 0 km/h: Profilabrieb ca. 8 mm, d. h. bei neuen Reifen Profil an Aufstandsfläche abgefahren, 
aus 100 bis 120 km/h: Reifen drucklos, Reifen geplatzt 
 
 
Steifigkeit: 
Steifigkeit 0,02 m entspricht 2 cm Deformationstiefe bei 1 g Belastung 
 
Bei einer Steifigkeit von 1000 N/m dringt z. B. ein Multibodysystem (MBS) bei einem Gewicht von 1000 N  
1 m in die Fahrbahn ein, deshalb Steifigkeit erhöhen, dass z. B. MBS-Fahrrad nur 1 cm in die Fahrbahn 
eindringt, somit 100.000 N/m 
 
 
Kollisionsgeschwindigkeit anhand der Stellung der Tachonadel: 
Neuere Tacho´s sind mit einem Schrittmotor ausgestattet, bei Stromausfall bleibt dann die Tachonadel stehen. 
Jedoch prüfen, ob die Tachonadel noch fest auf der Welle sitzt. Aus Crashtests ist bekannt, dass die Stellung 
der Tachonadel mit der Kollisionsgeschwindigkeit weitgehend übereinstimmt. Eine sichere Verwertbarkeit ist 
jedoch nicht gegeben. 
 
Durch hohe Beschleunigungskräfte kann die Tachonadel auf dem Ziffernblatt aufschlagen und dort Spuren 
hinterlassen, evtl. sind diese unter Vergrößerung (Lupe, Mikroskop) erkennbar. 
 
 
Schräglaufwinkel Reifen: 
Niederquerschnittsreifen, z. B. …/45   (Reifenquerschnitt h/b = 45%): Schräglaufwinkel ca. 2 - 3° 
 
 
EES-Werte mit deformierbarer Barriere (EURO-NCAP, ADAC …) 
Die deformierbare Barriere nimmt energetisch ca. 20 % auf, d. h. bei vk = 64 km/h dann EES ca. 55 km/h 
 

Fahrzeug > Fahrzeugdaten > Stoßparameter > 
Kontaktreibung 
z. B. Leitplanke 0,2 bis 0,3 
 



 

 

Windschutzscheibenbruch trotz Airbag: 
Europäische Fahrzeuge: Frontscheibe bricht trotz Airbag ab einem ∆v von ca. 40 – 45 km/h bei nicht 
angeschnallten Insassen oft durch, bei 2-stufigem Airbag hält die Scheibe besser 
 
 
Übersetzung Lenkgetriebe: 
Lenkgetriebeübersetzung ohne Servounterstützung: ca. 20:1 
Lenkgetriebeübersetzung mit Servounterstützung:    ca. 15:1 
d. h. 10 º Lenkwinkel entspricht dann 150 º bis 200 º Lenkraddrehung 
 
 
Reifenmodell: 
Reifen H/B = 70 % (z. B. 175/70 R 14):  max. Schräglaufwinkel ca.  10 º 
Reifen H/B = 50 % (z. B. 205/50 R 15):  max. Schräglaufwinkel ca.    5 º 
Reifen H/B = 30 % (z. B. 315/30 R 18):  max. Schräglaufwinkel ca. 3-4 º 
 
Bei zu geringem Luftdruck erhöht sich der Schräglaufwinkel, z. B.  
bei Luftdruck 0,4 bar: max. Schräglaufwinkel geschätzt  20 º 
bei Luftdruck 0,0 bar: max. Schräglaufwinkel geschätzt  30 - 40 º 
 
 
1.10 Ausdruck ohne Geschwindigkeitsmaßstab 
 
Einstellungen: Stöße und v-Dreieck deaktivieren 
 
  



 

 

1.11 Installation unter Windows 64 Bit 
 
Die 64 Bit Version von Windows führt zu kürzeren Simulationszeiten, auch mit der 32 Bit Version von PC-
Crash. Die 64 Bit Version von PC-Crash führt kaum zu einer weiteren Verkürzung.  
 
Der Austausch von den blauen Dongle´s ist deshalb nicht erforderlich. Die Dongle´s für die 64 Bit Version von 
PC-Crash sind grün. 
 
Empfohlene Einstellungen: 

- Automatische Speicherung aus  
             
 
 
 
 
 
 
 
 

- Grundeistellungen:  
„Verzeichnis automatisch aktualisieren“ aus  

             
 
 
 
 
 
 

1.12 Symbolbibliothek 
 
Symbole fehlen: 
 
Button Symbolbibliothek in Menüleiste „Zeichnen“ anklicken 

 
 
mit rechter Maustaste auf Kopfzeile klicken, Bibliothek öffnen 

 
 
Pfad: …PCCrashXX\Symbols\TrafficSigns.lbr  auswählen, OK 
 
neues Symbol hinzufügen oder neue Symbolbibliothek anlegen: 
 
auf der Homepage von DSD ist ein Tutorial hinterlegt, bei dem die Vorgehensweise als kurzer Film abgespielt 
werden kann:   www.dsd.at  
ab Version 10.0: 

 

 



 

 

  
 
 
1.13 Update PC-Crash (www.dsd.at) 
 
Menüleiste > ?: 

      
 
jetzt (vor dem Herunterladen) PC-Crash schließen! 
 
oder: 
- Internet-Verbindung herstellen 
- Windows-Explorer: Verzeichnis „PCCrashXX > updater.exe“ anklicken 
 
Fehlermeldung: „no connection to internet available“ 
- Windows-Explorer: Verzeichnis „PCCrashXX > settings.ini öffnen (z. B. Doppelklick) 
- den Eintrag „checkconnection=true“ auf „checkconnection=false“ ändern, dann speichern und schließen 
 
 

  

 

Symbolbibliothek befindet sich in der 
Explorer-Toolbar 



 

 

1.14 Sprache einstellen 
 
Grundeinstellungen > Vorgaben 

   
 
 
1.15 Symbolleiste anpassen 
 

 

 
 
Mit der Maustaste in die Symbolleiste ziehen (Drag and Drop), 
bis vertikaler schwarzer Balken erscheint. 
 
Zum Löschen Fenster „Anpassen“ öffnen, mit Maustaste 
in freien Bereich (Bildschirm) rausziehen 
1.16 eigenes Logo einfügen 
 

Sprache umstellen, wenn bereits Deutsch eingestellt war (und 
dennoch Menü´s auf Englisch angezeigt werden),  
 auf z. B. Englisch umstellen,  
 Programm schließen  
 wenn Abfrage „Speichern“ kommt:          „nein“,  
 PC-Crash neu starten,  
 Abfrage „Soll neue Symbolleiste übernommen werden“           „ja“ 

Mit rechter Maustaste auf freien Bereich in der 
Symbolleiste klicken, dann „Anpassen“ 
 

Befehle > z. B. „Bitmap“ > „Bitmap 
rotieren“ 

 



 

 

  

 
 
Dateipfad zum Logo eingeben, Position festlegen 
 
 
1.17 Benutzerhandbuch / Hilfefunktion 
 

 
 
 
F1-Hilfefunktion im Programm aufrufen: 
 
Betreffendes Fenster markieren, dann „F1“ drücken 
 
(anschließend Hilfe-Fenster schließen, nicht nur minimieren, sonst erscheint beim nächsten Hilfe- Aufruf das 
vorige Hilfe-Thema) 
 
 

Button „?“ drücken, „Benutzerhandbuch öffnen“ 



 

 

2. Unfallanalyse 
 
2.1 Fahrzeug.Dxf, Grundsätzliches 
 
Dxf-Größe wird beim Einfügen auf die Fahrzeuglänge (Fahrzeug > Fahrzeugdaten) skaliert. Wenn am Dxf-File 
die Mittellinien über den Umriß hinausragen, wird das Dxf deshalb zu klein wiedergegeben.  

 
 
In diesem Fall das Dxf manuell skalieren: 
Gesamtes Dxf markieren, Button „ausgewähltes skalieren“ anklicken 

 
 
Im Fenster „ausgew. Zoomen“ Pfeil-Button betätigen, bis Dxf-Größe stimmt, dann OK und Dxf in 
Fahrzeugumriß einpassen 

 
 
Fahrzeugumrißlinie neu erzeugen: 
 

 
 
  

Zuerst „Zeichnung bearbeiten“, 
gesamtes Fahrzeug markieren,  
dann „Datei“ und anschließend 
„Fahrzeugumriss erzeugen“ anklicken 



 

 

2.2 Fahrzeug.Dxf, Radstellung nach vorn verschieben 
 

1. Überhang verkleinern, z. B. -0,15 m 
2. Abstand SP-VA vergrößern, im Beispiel +0,15 m 
3. Federung anpassen 
4. dxf richtig positionieren (Fahrzeug > Fahrzeug-Dxf > Zeichnung bearbeiten) 

 
 

2.3 Fahrzeug.Dxf, Schwerpunktlage anpassen 
 

1. Abstand SP – VA ändern (Fahrzeug > Fahrzeugdaten) 
2. Federung anpassen 
3. bei älteren Versionen: dxf richtig positionieren 

 
 
2.4 Fahrzeug.Dxf, Umrisslinie entfernen 
 

 
 
 
2.5 Fahrzeuge gemeinsam verschieben: 
 
Taste „Alt“ + verschieben, Fahrzeuge und Stoßpunkt werden gemeinsam verschoben 
Taste „Alt“ + verdrehen, Fahrzeuge und Stoßpunkt werden gemeinsam verdreht 
 
  

- Fahrzeug-Dxf öffnen 
- Dxf mit leerer Bezeichnung markieren 
- Zeichnung bearbeiten 
- Umrisslinie löschen 



 

 

2.6 Fahrzeug.Dxf wird nicht angezeigt: 
 
Es kann vorkommen, dass das 2D-dxf nicht angezeigt wird, da sich dieses unter einem Bitmap befindet. 
Abhilfe:  
 

 
 
 
2.7 Fahrzeuge deformieren 
 
Fahrzeugdeformationen vor der Simulation im Dxf-File einzeichnen (zur genaueren Bestimmung der 
Kollisionsstellung): 

 
- Fahrzeug-Dxf kopieren 
 
- zweites Dxf markieren 
 
- gültig ab -0.01 s setzen 
 
 
 
 
 
 

 
zweites Dxf markieren 
 
„Zeichnung bearbeiten“ anklicken 
 
Zeichnung mit Zeichenwerkzeug 
bearbeiten 
 
 
 
 
 

 
  

 

 

- Fahrzeug-Dxf öffnen 
- Links dargestellten 

Haken aktivieren 



 

 

Fahrzeuge automatisch deformieren: 
 

 
 
 
2.8 Langholzfahrzeug / Nachläufer 
 
Sattelzugmaschine und Sattelanhänger laden 
 
 
 
Fahrzeugdaten Sattelanhänger ändern, z. B. 

 
 
 
 
 
 

Anhängerkopplung Sattelzugmaschine z. B.: 

 
 
Lenkkinematik Nachläufer einstellen: 

Nach dem Verkoppeln: 
Federung SZM und SAnh auf „hart“ stellen 

Fahrzeuge werden anhand der 
Eindringtiefe und der Berührebene 
automatisch deformiert 
 

 

 



 

 

     
 
In Abhängigkeit vom Knickwinkel zwischen SZM und SAnh „übersteuert“ dann der Nachläufer je nach 
eingegebenen Werten. Die Werte „0“ entsprechen dem Lenkverhalten eines normalen Sattelanhängers. Je 
größer die eingegebenen Werte sind (z. B. „2“), umso stärker lenkt der Nachläufer.  
 
Die Räder des Nachläufers werden proportional zum Knickwinkel gelenkt. Beispiel mit obigen Werten: 
 

  
 
 

  



 

 

2.9 Kraftomnibus / KOM, 3. Achse gelenkt / Lenkachse 
 

 
 
 

2.10 Stoßparameter optimieren 
 
Es können (neben den Endlagen oder Zwischenpositionen) auch Reifenspurpunkte als zusätzliche 
Optimierungskriterien eingefügt werden  
 

 Auswahl über Menüzeile „Zeichnen“ 
 
 

 
 
Bei Grundeinstellungen, beachten: 
 

 Spuren als dxf mit dem 
Zeichenprogramm nachzeichnen 

 
 Reifenspurpunkte auf die Spuren setzen 
 
 Reifenspurpunkt markieren und in 

richtige Richtung drehen 
 
 auf Reifenspurpunkt doppelklicken, 

Fahrzeug auswählen und Reifen 
zuordnen 

 
 es können mehrere Reifenspurpunkte 

auf einer Spur eingefügt werden 
 
 Gewichtung normal 100 % 
 
 Penalty: zusätzliche Fehlerabweichung 

 Stoßpunkt auf Überlappungsbereich begrenzen 
 
 Stoßerkennung 
 
 Endlagensimulation 
 
 Sekundärkollisionen automatisch berechnen 

Fahrzeug > Fahrzeugdaten > Lenkkinematik > 
„Lenkkinematik verwenden“ anklicken 
x0 = theoretischer Knickwinkel, wenn dieser 
überschritten wird, wird mit k1 gelenkt, siehe auch 
Benutzerhandbuch PC-Crash 
Innen = kurveninneres Rad 
Außen = kurvenäußeres Rad 
 
Empfohlene Vorgabewerte, wenn x0 = 0 
(abhängig vom Radstand und Fahrzeugbreite): 
Innen    k1 = -0,5 
Außen   k1 = -0,45 
 



 

 

 
 
Fahrdynamik > Sequenzen:  
Bremsverzögerungswerte für Auslaufbewegungen eingeben! 
 
 
Weitere Optimierungsparameter: 
 

 
 
dann Optimieren: 
                                                                       

               
 
  

In dieser Maske können weitere Simulationsparameter 
ausgewählt werden. 
 
Maske „Erweitert“ öffnen, mit rechter Maustaste „Neues 
Element“ einfügen, dann entprechende Parameter 
auswählen 
 
Hilfe aufrufen / Erläuterung der Bezeichnungen: 
Betreffendes Fenster markieren, „F1“ drücken 
 
(anschließend Hilfe-Fenster schließen, nicht nur 
minimieren, sonst erscheint beim nächsten Hilfe- Aufruf 
das vorige Hilfe-Thema) 

„Unterschreitung der 
Mindestenergie“ anklicken 



 

 

z. B. bei Krad: Winkelfehler auf 0 % setzen, da Drehung rein zufällig 
 

 
 
bei Frontalkollision: EES vorgeben (nur bei einem Fahrzeug), Gewichtung Gesamt-EES 100 % 
nach dem Ändern von EES: Button Startposition (neue Simulation) klicken, sonst wird alter Wert berücksichtigt 
 
zuerst genetischer Algorithmus, dann ggf. Monte Carlo, evtl. mehrmals, System speichert beste Variante, ggf. 
nochmals genetischer Algorithmus 
 
Optimierungsdiagramm: 
Diagramme, Stoßoptimierung, Geschwindigkeiten 
 
 
Unterschiede: 
genetischer Algorithmus: zielgerichtete Optimierung, ohne Eingabe von vmin und vmax 

 empfohlen: zuerst genetischer Algorithmus, ergibt genaue Ergebnisse in 
 vernünftiger Rechenzeit 
Monte Carlo: vmin und vmax vorgeben, rein zufällige Suche 
 
Bei Monte Carlo können Diagramme der Iterationsschritte angezeigt werden, die „Sicherheit“ des Ergebnisses 
kann als %-Fehler dargestellt werden. 
 

 
 

 

 „F2“ bzw. Optionen \ Diagramme \ Diagramme \ 
Stoßoptimierung \ Geschwindigkeiten 



 

 

 
 
 

2.11 Spurverfolgung / Fahrermodell 
 
Punkte einfügen / löschen: rechte Maustaste 
 
Spurverfolgung exakt: 
Fahrzeug > Fahrermodell: Vorausschaudauer 0 
PID-Tangentenlenkung aktivieren 
 
Fuzzy-Modell: eher unscharf, fährt nicht exakt 
auf dem vorgegebenen Pfad, fährt jedoch stabil,  
für höhere Geschwindigkeiten geeignet 
 
PID-Tangentenlenkung fährt exakt, wird aber 
leicht instabil, dann P verkleinern, z. B. 20 oder 10 
und Vorausschaudauer 0,1, 
eher für geringere Geschwindigkeiten verwenden 
 
max. Lenkgeschwindigkeit in der Praxis, z. B.  
Verreißen des Fahrzeuges: ca. 360 º/s am Lenkrad,  
damit das Fahrzeug gut auf dem Pfad fährt, 800 º/s am 
Lenkrad eingeben 
 
max. Lenkwinkel am Rad bei Pkw ca. 40 º, bei Lkw ca. 60 º 
 
Fahrzeuge auf vorgegebene Spur verschieben: 
Taste „Shift“ + verschieben 
 
  

 

Die Werte mit dem niedrigsten 
%-Fehlerwert befinden sich 
unten, somit liegt dort die größte 
Wahrscheinlichkeit bzw. 
Sicherheit 



 

 

2.12 Spurverfolgung / Krad / Zweirad 
 
Ist ab der Version 13.0 möglich. 
 

 
 
Es kann z. B. über Sequenzen eine Kurvenfahrt oder ein Spurwechsel eingegeben werden, auch hier fällt das 
nicht um. Die Kombination mit einer Bremssequenz ist möglich. 
 
Siehe auch Benutzerhandbuch Kapitel 4.2 
 
ESP: 
 

 
 

    
 
 
  

Wenn das ESP im Rechenmodell verwendet wird, zwingend das 
Reifenmodell TM-Easy verwenden und den Integrationsschritt auf 
weniger als 1 ms einstellen, da die Regelfrequenz des ESP hoch 
ist. 
 

Ansonsten ist das lineare Reifenmodell 
ausreichend, hier jedoch (aufgrund neuerer 
Erkenntnisse) den max. Schräglaufwinkel 
auf 3 bis 4 Grad einstellen 

Bei Fahrzeugdaten „Zweirad“ eingeben, 
Schwerpunkthöhe eingeben, fertig. 
 
 



 

 

Kurvenfahrt entsprechend der Ackermann-Lenkung: 
 

   
 
 
Pfad nachfahren mit 4-Achs-Lkw: 
 

 
 
Sequenzen > Reibungspunkt einfügen, auf 2. Achse Reibung 0.00 eingeben, der Lkw fährt dann auf dem Pfad 
Oder: über Geometrieveränderung 2. Achse anheben (Sequenzen > Punkte > Geometrieveränderung) 
 

    
 
  

Kinematik-Modell auswählen 
 
Spur vorgeben, Fahrdynamik > Spurzuordnung >  
„Mitte Hinterachse“ auswählen 
 

In den Sequenzen können Lenkwerte 
für die 2. Achse eingegeben werden 
(1. Achse hat größere Lenkwinkel) 
 



 

 

2.13 Pfad für Spurverfolgung / Mesh-Umgebung ausblenden: 
 
Neuen Layer für das Mesh erstellen, Mesh in diesen Layer verschieben, Mesh kann dann ausgeblendet 
werden 
 
 

2.14 Stoß allgemein: 
 
Stoß wird nicht erkannt (z. B. gegen Baum): 
 
Ursache: 
Wenn bei einem Integrationsschritt noch kein Baumkontakt vorliegt und beim nächsten Integrationsschritt der 
Baum mit der Fahrzeugfront bereits durchfahren worden ist, wird der Stoß nicht erkannt. 
 
Abhilfe: 
Baum dicker wählen (Länge und Breite in Fahrzeugdaten) oder / und Integrationsschritt verkleinern (Ampel), 
Berechnung dauert dann aber länger. 
 
Stoß wird nicht erkannt (z. B. gegen „Wall“): 
Basiswerte: > „INIT“ 
Evtl. Sequenz vorgeben 
Bei Neigungspolygon: Wall liegt auf ´Null-Ebene, nach „INIT“ > bewegen 
 
 
k-Faktor, Berührebene usw. für weitere Anstöße vorgeben / fixieren: 
In manchen Fällen ist es erforderlich, den k-Faktor, die Berührebene usw. zu fixieren, z. B. beim Baumanprall 
oder beim Leitplankenanstoß 
 

 
 
 
Fahrzeuge gemeinsam verschieben: 
Taste „Alt“ + verschieben, Fahrzeuge und Stoßpunkt werden gemeinsam verschoben 
Taste „Alt“ + verdrehen, Fahrzeuge und Stoßpunkt werden gemeinsam verdreht 
 
Bei geöffneten Stoßfenster: 
Geschwindigkeitsvektor drehen: Shift + drehen   ny wird gedreht 
Fahrzeug drehen: Strg + drehen   Fahrzeug wird um den Stoßpunkt gedreht 
Stoßpunktlösegeschwindigkeit: 
∆v jetzt (OS 2018) bei modernen Fahrzeugen eher bei 3 km/h, nicht mehr 4 km/h, wegen Fußgängerschutz 
sind erste 15 cm Eindringtiefe weich, absorbieren Energie gut 
 

Fahrzeug > Fahrzeugdaten > Stoßparameter 
 
Berührebene: 
z. B. Baumanprall ohne Abgleiten: 90 Grad 
 
z. B. Leitplankenanprall mit Abgleiten:   0 Grad 
 



 

 

Fahrzeuge auf vorgegebene Spur verschieben: 
Taste „Shift“ + verschieben 
 
 
2.15 Umkippen / Überschlag: 
 
Das Umkippen eines Fahrzeuges wird wesentlich durch die Schwerpunktshöhe und von der Federsteifigkeit 
beeinflusst. Wenn die Federsteifigkeit reduziert wird, erhöht sich die Neigung des Fahrzeuges, es kommt dann 
eher zum Kippen. 
 
 

2.16 Mehrkörpersystem, Wand aus Einzelsteinen einfügen 
 
Explorer \ Mutibody \ PBD Softbody \ „wall 240 elems 20230323.mbdef“ einfügen 
 
Um z. B. einen Schneehaufen in die Simulation einzubeziehen, können mehrere Wände, z. B. drei, 
hintereinander eingefügt werden. Für einen Schneehaufen ist das Modell derzeit jedoch noch nicht validiert. 
 
Die Form der einzelnen Steine (Shape) kann geändert werden:  Simulation \ Mehrkörpersystem \ Shape 
Ebenso kann die Geometrie angepasst werden 
 
 
2.17 Mehrkörpersystem (z. B. Motorradunfall und Fußgängerunfall) 
 
Bei Verwendung vom Mehrkörpersystemen (MKS) bzw. Multibodysystemen (MBS) wird immer mit dem 
steifigkeitsbasierten Stoßmodell gerechnet. 
 

 
 
 
 
Wenn vorhanden: „output_1.dxf“ als 3D-Fahrzeug für die MKS-Simulation (auch für alle anderen Simulationen) 
verwenden. Das Modell ist homogener, damit für die Simulation besser geeignet. Jedoch: „output_1.dxf“ wurden 
automatisch generiert, manche sind fehlerhaft, dann erscheint kein Vorschaubild in der Explorer-Toolbar. 
 
MKS (MBS) ab 2014: neue Drehgelenke usw., siehe Handbuch unter Punkt „Multibody new joint types“ 
(direkter Aufruf über „F1“ aus der geöffneten Maske möglich) 
 
 

Fahrzeug 1 laden,  
 
Schwerpunkt, Federung, Fahrzeug-Höhe, Überhang 
anpassen,  
 
3D-Fahrzeug laden: z. B. DirectX > „….enc“,  
für Fußgängerunfall DirectX > output_1.dxf“ verwenden, 
Ergebnis dann realitätsnäher 
 
Achtung: 
Es muss mindestens ein Fahrzeug aus der Datenbank 
geladen sein, Kollision zwischen z. B. zwei MKS (z. B. 
Fußgänger-MKS und Motorrad-MKS funktioniert sonst nicht, 
Fahrzeug kann deaktiviert werden. 



 

 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Fahrzeug DXF Rad Kontakt: 
 

 
 
ODE Solver: 

 

Fahrzeug 2 Motorrad laden:  
Button DAT oder Explorer-Toolbar > Fahrzeugdaten 
 
(Pfad: C: > Users > Admin > Documents > PCCrash 
> CustomVehicles > Multibody > ... 
oder direkt aus Bibliotheken > Dokumente > PCCrash 
> CustomVehicles > Multibody > ... 
 
Fahrzeug > Mehrkörpersystem > Vorgaben > 
Systemeinstellungen:  Button:"3D Dxf Fz. Kontakt" 
anklicken 
 
Bei Fußgänger: zmin auf null stellen (=Bodenkontakt) 

Fahrzeug > Mehrkörpersystem > 
Vorgaben > Systemeinstellungen:  
Button:" Fahrzeug DXF Rad Kontakt" 
anklicken 
 
Rad wird dann als zusätzlicher Körper 
berücksichtigt, z. B. Krad verhakt sich 
dann eher 

Neuere Zweirad-MKS (z. B. 
„2014_Kawasaki_ZX6R_plus_rider 
20220111.n“ sind mit Rädern aus 
mehreren Körpern zusammengesetzt 
(„aufgegliederte Räder“), wirkt sich bei 
der Fahrdynamik nur unwesentlich 
aus, jedoch bei Kollisionen 



 

 

 

 
 
Wenn mehrere Mehrkörpersysteme  (= Multibodysysteme) geladen sind, können diese einzeln verschoben 
werden, wenn die Shift-Taste gedrückt wird. z. B. Motorradfahrer 
MKS-Daten ändern:  
 
nicht „alle Systeme“, sondern z. B. „Fußgänger1“ auswählen 
 
Achtung: nach jeder Änderung am MKS immer „neue Simulation“ drücken 
 
Blockierung Vordergabel Motorrad oder Fahrrad aufheben: 

 
Fahrzeug > Mehrkörpersystem > Gelenke             „Front forks – 
Front Wheel“ auswählen 
 
„x-Achse gesperrt“          Haken entfernen (dann Kugelgelenk, 
Zylindergelenk funktioniert derzeit noch nicht) 
 
 
 
 
 
 
 
 
 
 

 
 

 

! 

MKS Motorrad oder Fahrrad: 
Rad im MKS rollt nicht,    schleift über den Boden, 
deshalb Reibung reduzieren! 
Fahrzeug > Mehrkörpersystem > Körper > „1 - Front Wheel“ 
 
Reibung Untergrund z. B. 0,1 bei frei rollendem Rad, z. B. 0,5 
bei gebremstem Rad 
 
auch Hinterradreibung („2 - Rear Wheel“) reduzieren! 
 
Vorgabe Reibungspolygon hat keinen Einfluss, da nicht über 
das Reifenmodell, sondern über das MKS gerechnet wird  
 

 

Wenn „ODE Solver verwenden“ angeklickt ist, werden 
Zylindergelenke berücksichtigt. Wenn nicht angeklickt, 
wird mit Kugelgelenken gerechnet. Ausschalten ist 
nur erforderlich, damit alte Projekte nachgerechnet 
werden können 



 

 

 
 
 
 
 

 
 
 
 
 

 
 
 

Wenn Mehrkörpersystem während oder nach der Kollision verschwindet: 
Integrationsschritt weiter verkleinern, ggf. MKS (Mehrkörpersystem) leicht anheben, z. B. zmin, = 0.01 m 
 
Wenn MKS zusammenbricht:  
MKS > Vorgaben > Systemeinstellungen > Solver auf „PBD/Softbody“ stellen (Standard = ODE Solver) 
Kollision zwischen MKS und PBD/Softbody geht derzeit (April 2023) noch nicht, kommt in Kürze 
 
Wenn Mehrkörpersystem in die Fahrbahn eindringt: 
Bei Steifigkeit von 1000 N/m dringt z. B. Mehrkörpersystem bei einem Gewicht von 1000 N    1 m in die 
Fahrbahn ein, deshalb Steifigkeit erhöhen, dass z. B. MKS-Fahrrad nur 1 cm in die Fahrbahn eindringt, somit  
100.000 N/m 
 
Wenn der Schwerpunkt höher als das Fahrrad ist, taucht das MBS auch in die Fahrbahn ein, dann 
Fahrzeughöhe von z. B. 0,5 m auf 0,8 m setzen. 
 
Neue MKS: 
Es ist jetzt eine Federsteifigkeit (MBS ab 2011) enthalten, damit das MBS (z. B. Fußgänger) nicht mehr 
zusammensackt.  
 
Entweder neueres MKS laden oder Federsteifigkeit vorgeben: Fahrzeug > Mehrkörpersystem >  
Gelenke          Steifigkeit eingeben,  0,1 bis 1 Nm/º, individuell für jedes Gelenk vorgeben 
 
Oder, evtl auch zusätzlich:  
MKS ausschalten bis kurz vor Kollision            rechte Maustaste             MKS einschalten, weiterrechnen 
Dann in Optionen > Diagramme > Optionen: Offset korrigieren bzw. einstellen 
 
z. B. „mot + driver 20140221.mbdef“ fährt stabil 
 
MKS-Einlaufbewegung simulieren: 

 z. B. Motorrad            MKS laden, zusätzlich normales Motorrad (*.dat) laden 
 normales Motorrad (*.dat) ausschalten              vorwärts simulieren 

Körperdaten Fußgänger ändern:  
MKS > Vorgaben > „Fußgänger 1“   
„aktuelles System“  
„Körperdaten ändern“ 
 

Integrationsschritt auf 0,5 ms oder kleiner (max. 1 ms) 
setzen, da sonst die rechnerischen Kräfte zu groß 
werden 

 



 

 

 normales Motorrad (*.dat) einschalten, MKS ausschalten             rückwärts simulieren 
 
MKS Motorrad, Antrieb Rad vorgeben: 
 

 
 
 
Aufsasse befestigen: 
 
z. B. Hände:  

 
 
Dann erneut „Einfügen“ anklicken, linke Hand mit Lenker verbinden, ggf. weiter Punkt verbinden 
 
  

Im Fenster „Mehrkörpersystem“ > Gelenke: 
Auswählen:  
 

 Alle Systeme 
 Nr. 1 – Rear Wheel - Engine Block 

 
Bei Reibung eingeben: z. B. 300 
Bei Geschwindigkeit eingeben: z.B. 57,1  
( = Soll-Geschwindigkeit in rad/s, bei einem Rad-
Durchmesser von 70 cm und einer Geschwindigkeit 
von 72 km/h entspricht dies 57,1 rad/s) 
 
z. B. Bremsung:  
Reibung z. B. 1000 (= Vollbremsung) 
Geschwindigkeit = 0 



 

 

Wenn Wurfhöhe Fußgänger zu groß:  
k-Faktor reduzieren, evtl. bis auf 0 

 
 
ggf. auch Kollisionsgeschwindigkeit Pkw reduzieren, (ggf. Auslaufverzögerung reduzieren, soweit vertretbar) 
 
Wurfweite: 

 
 
 
Animierte Fußgänger laden: 
Bis Version 9.2:  Button „DAT“, aus Verzeichnis „PCCrashXX“ Pedestrian.dat laden 
Ab Version 10.0: Button „DAT“, aus Verz. „CustomVehicles > Objects > Pedestrian“ Pedestrian.xml laden 
 

                                   
 
animierte Person laden:  
Fahrzeug > Fahrzeug-Dxf > Datei > 3D Darstellung 
PCCrash83 > 3DDxf > DirectX > Human > People Animated > Boy running > boy 04animated2880r.enc 
 

Hysterese verkleinern, z. B. von 0,1 auf 0,05: 
Wurfweite wird geringer 
 
Steifigkeit erhöhen, z. B. von 215.820 auf 400.000: 
Wurfweite wird geringer 
 
Pkw-Federung hart: Wurfweite wird etwas größer 



 

 

 
 
Sequenz eingeben, Geschwindigkeit vorgeben, Schwerpunkt herabsetzen (fällt sonst um) 
 
Krad in 3-D-Ansicht schräg stellen: 
vorher Schwerpunktshöhe vorgeben! 
Simulation > Basiswerte > Wanken    z. B. -20 Grad = Neigung nach links 
wenn Werte nicht übernommen werden, Geschwindigkeit um 1 km/h ändern, dann werden alle Werte 
übernommen 
 
Hinweis: Rutschen Motorrad: 
Eingabe Bremsverzögerung z. B. 3,5 m/s2 in der Sequenz führt dazu, dass während der Querstellung des 
Krades dennoch die Maximalverzögerung (z. B. 8,5 m/s2) berücksichtigt wird. Deshalb Reibungssequenz mit 
µ = 0,35 vor dem Sturz einfügen. Auch Reibungspolygon ist möglich. 
 
Ab der Version 11.1 sind 3 neue MBS-Fahrräder enthalten: 
 
 Child rigid with rider ....................... Kinderfahrrad 
 Diamond rigid with rider ................ Herrenfahrrad 
 Wave rigid with rider ...................... Damenfahrrad 
 
Die Vorder- und Hinterräder sind ebenfalls als MBS-Körpern aufgebaut und drehen sich bei der Fahrt. Die 
Kontakte beim Anstoß werden hierdurch rechnerisch besser erfasst, die Auslaufbewegungen werden 
realistischer dargestellt 
 
 
  



 

 

2.18 Mesh-Modell / zusätzlichen Körper einfügen 
 

 
 

 
 
 

Körper einfügen, z. B. Fahrradkorb: 
Fahrzeug \ Mehrkörpersystem \ Körper 
„Einfügen“ anklicken, Name (Korb) eingeben, 
Geometriedaten eingeben (n = Ordnung, je 
größer desto eckiger), Masse eingeben 

Fahrzeug \ Mehrkörpersystem \ Gelenke 
„Einfügen“ anklicken, dann „29 - Korb“ und „7 - 
Handlebar“ auswählen, einmal Maske wechseln 
(Körper – Gelenke), dann ist Gelenk unter „27 – 
Korb – Handlebar“ gespeichert 
 



 

 

2.19 Mesh-Modell / Insassensimulation / HWS 
 
Beim Mesh-Modell handelt es sich um ein Kraft-Stoß-Modell, bei dem die Deformationen des Fahrzeuges über 
den Kontaktflächen berechnet werden. Es ist deshalb gut geeignet, bei niedrigen Geschwindigkeiten die 
Anstoßpunkte und Kontaktbereiche darzustellen. Die Kräfte wirken über die gesamte Stoßzeit, d. h. die 
Stoßzeit ist nicht „Null“, wie bei konventionellen Stoßmodellen. Das Mesh-Modell ist deshalb auch gut für 
eine Insassensimulation und die Ermittlung von Belastungen bei HWS-Verletzungen geeignet. 
 

    
 
Wegen der kürzeren Rechenzeit Teilbereiche des *.dxf löschen:  
 

 
 
 
 
 
 
 
 
 

Zur Simulation 3DDxf für die beteiligten Fahrzeuge laden, 
empfohlen: DirectX, andere (FCE, idf, x61) auch möglich, 
x61 ist schnell bei Berechnungen, jedoch wenig detailliert, 
z. B. sind die Radläufe offen, was zu rechnerischen 
Verhakungen führen kann 
 
Auswahl über Explorer-Toolbar > 3D Fahrzeuge > DirectX 
> Cars > „Hersteller“ > „Typ“ 
 
„output_1.dxf“ nicht *.dxf, laden (einheitliche 
Flächengröße, alles Dreiecke, ist für die 
Kontaktberechnung besser und auch schneller),  
 
*.enc ist nur für bessere Darstellung (bessere Grafik bzw. 
Optik) nützlich 

Erst dann „Mesh-Kontaktmodell verwenden“ anklicken, 
sonst sind das 3D-Dxf und das Mesh-Modell in der 3-D-
Darstellung überlagert 

Fahrzeug > Fahrzeug-Dxf > 
"Zeichnung bearbeiten": 
Zeichnung anklicken, Gruppierung 
aufheben, für die Simulation nicht 
benötigte Bereiche löschen 



 

 

Fahrzeug > Fahrzeug-Dxf           „3D Fahrzeug für Mesh Generierung 
verwenden“ bei erstem Fahrzeug anklicken, dann Button „OK“ 
drücken, erneut Maske öffnen und bei anderem Fahrzeug ebenfalls 
„3D Fahrzeug für Mesh Generierung verwenden“ anklicken und 
Button „OK“ drücken. Somit beide (alle) Fahrzeuge entsprechend 
markieren. 
 
Schwerpunkthöhen (bei beiden Fahrzeugen!) eingeben, zwingend! 
 
Kinetik-Modell, nicht Kinematik-Modell verwenden!  
(schaltet nicht selbsttätig um, es wird sonst kein Stoß gerechnet) 

 
Spurpunkte ggf. löschen, Fahrzeuge kurz vor erster Berührung positionieren 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Wichtig: wenn versehentlich oder bewusst eine neue Simulation gerechnet worden ist: 
MKS deaktivieren („Ampelsymbol“) Simulation rechnen, MKS wieder aktivieren,  
sonst ergibt sich eine andere Auslaufbewegung ! ! ! 
 
 

 

 

 

Wenn ohne Mesh-Modell 
gerechnet wird: 
 
in Einstellungen > 
Simulationsparameter > 
„Stoßerkennung“ muss aktiviert sein! 
 

Ampelsymbol („Fahrzeuge ein/ausschalten…“) anklicken: 
 
„jeden Integrationsschritt speichern“ und Integrationsschritt 
auf 1 ms (oder niedriger) einstellen (wegen Auflösung 
Beschleunigungsverlauf),  
 
Berechnung dauert dann entsprechend länger, das einfache 
Mesh-Fahrzeugmodell (ohne 3D-Dxf) wird jedoch sehr schnell 
berechnet, ist aber ungenauer 
 
Tipp: 
z. B. bei Frontanstoß den mittleren Bereich und den Heckbereich 
im Fahrzeug-Dxf löschen, Berechnung wird deutlich schneller 
 
Dann: Simulation zunächst ohne Insassen rechnen ! ! !  



 

 

                                                                   
 
 

 
 
Fahrzeuge transparent darstellen: 
 

 
 
 

Wenn Fahrzeuge bei der Primärkollision zu weit ineinander 
eindringen, ist auch die Stoßzeit zu lang, dann Steifigkeit 
Chassis auf „hart“ oder noch steifer (max. 0.001 m möglich) 
erhöhen: 
 
Bei Steifigkeit von 1000 N/m dringt z. B. Mesh-Modell bei 
einem Gewicht von 1000 N    1 m in einen unnachgiebigen 
Körper ein, deshalb Steifigkeit erhöhen, dass z. B. Mesh-
Modell nur 2 cm eindringt, somit 50.000 N/m 
 
(Stoß-Eindringtiefe oder Integrationsschritt verkleinern ist ohne 
Einfluss) 

Ab PC-Crash Version 12.0: 
Transparenz einschalten, geht dann 
bei allen Farben 

Wenn bei Sekundärkollisionen 
Fahrzeuge ineinander eindringen: 
 
Stoßeindringtiefe reduzieren, evtl. bis 
auf „Null“ 



 

 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
Tipp: 
Wenn die Füße des Insassen nach oben geschleudert werden, sitzt das MKS zu tief, unterhalb der 
Berührebene, hierdurch entsteht ein rechnerischer Impuls nach oben. 
 

Explorer-Toolbar > Fahrzeugdaten: 
 
Innenraum laden: Multibody > 2 passengers + cockpit + 
belted both.mbdef 
 
Achtung: 
MBS (Multibodysystem) nicht in das Fahrzeug ziehen, 
sondern nur auf die Bildschirm-Arbeitsfläche, wird sonst 
als Kontaktellipsoid geladen und beim 
steifigkeitsbasierten Stoßmodell als solches verwendet 

 

Simulation > MKS: Insasse Start und Ende 0          
Berechnen  (nicht: Startposition und neue Simulation),  
dann sitzt MKS im Fahrzeug,  
 
Höhe z eingeben            Berechnen  
Cockpit im Fahrzeug richtig positionieren, über 
manuelle Eingabe, nicht verschieben, ggf. erneut 
anpassen, mit Kamera prüfen 
 
k- Faktor Sitzlehne auf ca. 0,6 bis 0,7 setzen (k=0,6 
ergibt etwas höhere Beschleunigungswerte):  
MKS > Vorgaben > aktuelles System (oder ein Körper,  
z. B. System 1 = Sitz) auswählen, > 
Systemeinstellungen > k-Faktor einstellen 

 
Start- und Endwerte setzen, „Fahrzeug > 
MKS: Insasse“ z. B. von -0.3 bis 1.5 s, 
(nicht: Startposition und neue Simulation), 
dann berechnen 
 
Hinweis: 
Zum Beginn der Simulation sinkt der Insasse 
wegen der Schwerkraft in den Sitz ein, 
deshalb die Simulation ca. 0,3 s (mind. 0,1 s) 
vor dem Stoß beginnen 



 

 

  



 

 

Darstellung als Gittermodell: 
 
Im 3D-Fenster: Darstellung > Anzeige Optionen 
 
 
 
 
 
 

 
 
 
Karosseriekontur deaktivieren: 
 

 
 
 
Zeitlupe: 
3D Darstellung > Animation berechnen 25 fps  0-0,5 s   Zeitlupe 10:1            es werden 250 fps erzeugt 
 
 
  

  

„Darstellung als Drahtmodell“ einschalten 
 
„Fahrzeuge“ ausschalten 
 
Das oder die Fahrzeuge werden dann als 
Gittermodell dargestellt 
 

Wenn die Karosseriekontur mit dem 3D-dxf überlagert 
ist: 
 

 
 
Stoß > „Mesh Kontaktmodelll verwenden“ deaktivieren 



 

 

Sensor setzen, bei exzentrischem Stoß: 
Es kann ein Sensor auf die Position des Insassen im Fahrzeug gesetzt werden, um z. B. die Kopfbewegung 
des Insassen genauer beurteilen zu können. . 
  

    
 
Sensorlage bezogen auf den Schwerpunkt des Fahrzeuges angeben oder den Pick-Up-Button verwenden 
 
Dann Optionen > Diagramme/x-Achse die relevanten Diagramme auswählen 
z. B. 1 vx = Geschwindigkeit Fahrzeug 1 in x-Richtung 
 
angezeigt werden: 
Geschwindigkeiten v in km/h Kurven 1, 2 und 3 
Beschleunigungen a in m/s2 Kurven 4, 5 und 6 
Winkel  in Grad Kurven  
Winkelgeschwindigkeiten  in rad/s Kurven 7, 8 und 9 
Winkelbeschleunigungen  in rad/s2 Kurven 10, 11 und 12 
Rotation über x-, y- und z-Achse   Kurven 13, 14 und 15 
 
 
Diagramme: 

 
 

    
 

Diagramme > MKS > 
Beschleunigung auswählen 



 

 

 
 
 
Diagramme glätten: 
Diagramme > Optionen > Diagramme x-Achse > Filter,  z.B. 60           alles über 60 Hz wird ausgefiltert,  
für Pkw-Deformation ist Filter 60 angemessen 
 
 
Verformungen darstellen: 

   
 

 
 

3D-Fenster: Darstellung > 
Anzeige Optionen > Fahrzeuge 
ausschalten, dann sind Räder 
jedoch auch nicht sichtbar 

Darstellung mit Rädern: 
Grundeinstellungen > Anzeigeoptionen > 
Dxf-Fahrzeugzeichnungen ausschalten 

Rechte Maustaste in das nebenstehende Fenster, 
„Alle Diagramme ausschalten“,  
dann z. B. „27 head - Res (=linker Insasse) und 
60 head - Res (=rechter Insasse)“ auswählen 
 
 



 

 

 
HWS: 
Beschleunigungsverläufe sind im EES-Katalog bei AZT-Versuchen hinterlegt, letztes Bild 
 
Anhaltswerte, keine genauen Grenzwerte: 
Heckanstoß: HWS-Verletzungen ab ca. 11 km/h Fahrzeug- ∆ v möglich, (vorbehaltlich medizinischer 
Beurteilung!) 
Frontalkollision: HWS-Verletzungen ab ca. 15 km/h Fahrzeug- ∆ v plausibel 
auch abhängig von Kopfstützenhöhe, (normale) Sitzposition, Kopfdrehung, Vorerkrankungen 
 
Fahrzeugbeschleunigung ist eher nicht relevant, da der Stoß in der Regel beendet ist, bevor der Kopf 
anprallt. Kurze Stoßzeiten bei z. B. hoher Struktursteifigkeit des Fahrzeuges, sind deshalb nicht relevant 
 
Andere Angaben: 
mittlere Fahrzeugbeschleunigung: Stoßzeit 0,1 s, am = dv / dt 
Grenzwert für HWS ca. 3 bis 4 g Fahrzeugbeschleunigung 
                                ca. 15 bis 20 g Kopfbeschleunigung 
Kopfbeschleunigung = ca. 3-5 mal Fahrzeugbeschleunigung 
Genauere Ausführungen finden sich z. B. im „Handbuch Verkehrsunfallrekonstruktion“ von Andreas Moser 
und Heinz Burg. 
 
HWS über das steifigkeitsbasierte Stoßmodell : 
Es kann zusätzlich über das steifigkeitsbasierte Kraft-Stoß-Modell (nicht Mesh-Modell) gerechnet werden, 
delta v Fahrzeug (aus Diagramm Weg-Geschwindigkeit entnehmen) kann als Grundlage verwendet werden, 
z. B. bei 100 ms Stoßdauer kann mittlere Fahrzeugbeschleunigung errechnet werden, Kopfbeschleunigung = 
ca. 3 – 5mal Fahrzeugbeschleunigung 
 
 
  



 

 

Videoanimation ohne Fahrzeuge: 
 

 
 

    
 
Ergebnis beispielhaft, kann als avi-File verwendet werden: 

 
 

2.20 steifigkeitsbasiertes Stoßmodell 
 

Ampelsymbol anklicken, Fahrzeuge 
deaktivieren wie nebenstehend 
markiert 

Ggf. Bitmaps deaktivieren 
 



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

\  
 
Schwerpunkthöhe für beide Fahrzeuge angeben, sonst liegt Schwerpunkt unten, Stoßkräfte wirken an 
Kontaktellipsoiden, anstoßende Fahrzeugpartien heben sich dann während der Kollisionsphase an. 
 
Ab der PCCrash- Version 10.2 funktioniert das Optimieren auch beim steifigkeitsbasierten Stoßmodell 

! ! 
Abhilfe: Fahrzeug > Fahrzeugdaten > Stoßparameter: 
Steifigkeit Chassis erhöhen, z. B. 0,001 m 
(=Mindestwert) 
 

Achtung: 
Wenn während der Kollisionsphase die Mitte der 
Kontaktellipsoide überschritten wird, kehrt sich die 
Stoßkraft um, was zu einem Beschleunigen des 
Fahrzeuges führt! 

Stoß > „steifigkeitsbasiertes Stoßmodell verwenden“ 
 
Es handelt sich um ein Kraft-Stoß-Modell, wie auch beim 
Mesh-Modell, jedoch werden hier Kontakt-Ellipsoide, und 
nicht Kontaktflächen, wie beim Mesh-Modell, verwendet 

 

Kontaktellipsoide anzeigen: 3D-Darstellung > 
Darstellung > Anzeige Optionen > Kontaktellipsoide        
anklicken, diese werden beim Stoß, auch mit 
Objekten z. B. Bäume, Häuser usw. zugrunde 
gelegt 



 

 

2.21 Schrankenverfahren Fußgängerunfall 
 
Unfallskizze fertigen, mit Kollisionsstellung und Endlagen, z. B. 
 

 
 
Zeichenprogramm, Button rechts unten anklicken 

 
 
Diagramm erscheint in Skizze          Diagrammursprung (x = 0) auf Endstellung Pkw platzieren  
Auf Diagrammbasislinie doppelklicken          Fenster wird geöffnet  
Bekannte Werte eingeben, z. B. 

     
 
Endlage Fußgänger: positiver Wert        vor Endstellung Pkw (kürzere Wurfweite) 



 

 

                                  negativer Wert        hinter (nach) Endstellung Pkw (längere Wurfweite) 
die y-Komponente ist ohne Einfluss auf das Ergebnis, nur zur Anzeige der Endlage 
Lage Splitterfeld in Bezug zum Ursprung des Diagramms angeben 
Es können 2 Wegschranken und 2 Geschwindigkeitsschranken definiert werden, üblicherweise ist 1 Schranke 
ausreichend, Ergebnis (beispielhaft): 
 

 
 
              dann ggf. zur Kontrolle Simulation mit MKS (Mehrkörpersystem) durchführen (siehe 2.7) 
 



 

 

                      
 
  

zur Simulation der Einlaufbewegungen Fußgänger aus Fahrzeugdaten 
laden, 
 
dann 3D-Fahrzeug laden 
3D Fahrzeuge > DirectX \Human > z. B. People Animated > Boy running 
 
normale Simulation durchführen 



 

 

2.22 Radkontaktspurenberechnung 
 

 
 
 

 
 
Streifendes Fahrzeug = rot = streifendes Rad  
Gestreiftes Fahrzeug = blau = Fahrzeug mit Radandrehspuren 
 

    
 
 
Bitmap laden,  
Bitmap drehen (Rot. Bitmap), 
Bitmap skalieren,  
Bitmap Höhe positionieren 
 
  

Geschwindigkeiten eingeben, 
Raddurchmesser eingeben (z. B. über 
markiertes Symbol, 
radialen Offset eingeben,  
ggf. Felgendurchmesser und 
Reifeneinfederung eingeben 



 

 

Tipps für Fotoerstellung: 
 Maßstab mitfotografieren, am besten waagrecht an Rädern, zus. senkrecht (für Skalierung) 
 Fotohöhe entsprechend Spurenhöhe 
 Fotos rechtwinklig zum Fahrzeug 
 Teleobjektiv verwenden, möglichst großer Abstand 

 
Ausdrucken: 
Aktiven Bildschirminhalt in Zwischenablage („Alt + Druck“ 
z. B. in WORD einfügen (Strg + V) 
 
 

2.23 Abschleppseil definieren 
 
Zuerst Fahrzeuge laden 
 
> Explorer Toolbar > Fahrzeugdaten > Multibody > Objects > Block.mbdef laden (sonst kann MKS nicht 
geöffnet werden) 
 

 
 

> Fahrzeug > Mehrkörpersystem > 
Feder/Dämpfer > Vehicle 1 auf Vehicle 2,  
dann Einfügen drücken 



 

 

 
 
Das Seil befindet sich dann zwischen dem Schwerpunkt Fahrzeug 1 und dem Schwerpunkt Fahrzeug 2 
 
Gelenkpunkte anpassen, beispielhaft wie folgt: 

 
 
 
 

Eingeben: 
transl. Steifigkeit: 130.000 N/m 
Dämpfung: 1.000 Ns/m 
Fmax:: 30.000 N 
Vorspannung: 0 N 



 

 

2.24 Reifenplatzer simulieren 
 
Schräglaufwinkel erhöhen, ca. 20 Grad Luftverlust simulieren 

 
 

 
z. B. Rad vorne links drucklos, z = 0,1 m: 
 
(kann in 3D-Ansicht betrachtet werden, hierzu Fahrzeug 
fahren lassen) 
 
 
 
 
 
 
 

 
Reibung verändern 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

  

 

 



 

 

2.25 Geometrieveränderung, z. B. abgerissenes Vorderrad 
 
Geometrieveränderung eingeben 

  
 
wenn z. B. Rad vorne links abgerissen, Geometrie vorne links um ca. 0,2 m anheben, d. h. z = 0.2 eingeben 

  
 
 
Alternativ: 
Abgerissenes Vorderrad kann auch durch negativen k-Faktor, z. B. -0,7, simuliert werden, dann Berührebene 
quer stellen 

 
 
  



 

 

2.26 Leitplankenanstoß 
 

 
 
Weitere Fahrzeuge laden, über Button „Fahrzeug aus der Datenbank laden“: 

 
 
 
Oder: 
Leitplanke als MKS einfügen 
 

   
 
 

Leitplanke laden (nur ebene Berechnung, 
ohne Punktwolke oder Mesh), am 
einfachsten aus dem Projekt Assistenten 
 
„roadside barrier 10 Elements“ auswählen 
 
oder (jedoch dann ohne Punktwolke oder 
Mesh): Explorer-Toolbar > Fahrzeugdaten 
> Objects > Roadside Barrier > z. B. db80 > 
db80_4m.dat 



 

 

2.27 Leitplankenmodell MUSIAC 
 
Explorer Toolbar > Fahrzeugdaten > MUSIAC > Leitplankenart auswählen, die Ausführung der Leiplanke wird 
bei einem Klick auf die *.CMP-Datei angezeigt, sortiert nach Rückhalteklassen gemäß EN-1317 (H1, H2, H3 
...) 
 
Zuerst *.pro und dann die zugehörige *.CMP ins PC-Crash-Fenster ziehen 
 
Button Simulation > Basiswerte > Position, Einlaufrichtung und Geschwindigkeit vorgeben 
(das Fahrzeuggewicht kann nicht verändert werden) 
 

 
 
Abbrechen bei zu langer Berechnungszeit: Rechenfenster schließen 
 
Die seitliche Verschiebung der Leitplanke ist realistisch, ergibt gute Werte 
 
 

2.28 Auffahren auf Leitplanken-Endstück 
 
Fertiges Projekt in der DVD vom OS 2019 
 
oder selbst anfertigen: 
 
mit Polylnien zeichnen: 
 
 
 
innere Polylinie markieren, ausgewähltes rotieren Button  
rotieren um y-Achse, z. B. 20º 
alles markieren, triangulieren 
 
2.29 Bordstein oder Gehweg überfahren: 
 
Einfachste und beste Möglichkeit: 

 

 

Ribbon Simulation > Musiac Multibody > 
Berechnen > tEnde vorgeben, Vorschlag: 
0,5 s wegen langer Berechnungszeit)  



 

 

  
 
 
Andere Möglichkeit: 

  
 
 
Aber: wenn eine „Wall“, z. B. mit einer Höhe von 10 cm (oder auch niedriger) eingefügt wird, wird nicht ein 
Überfahren, sondern ein Stoß gerechnet.  
 

„Wall“ als Fahrzeug einfügen  
 

Neigungspolygon einfügen und 
anheben (ZRef) 



 

 

  
 
 
Oder einfache Möglichkeit: Anstoßverlust vorgeben 
 

     
 
 
 
 
 
 
 
 
 
 
 
Auch möglich, sachlich jedoch nicht richtig: negativen k-Faktor einsetzen 
 
  

Abhilfe: 
Fahrzeug > Fahrzeugdaten: 
Berührebene neigen, so dass die „Mauer“ 
während des Stoßes überfahren wird.  
 

 



 

 

2.30 Texturen (Oberflächen), z. B. Wasserfläche laden 

z. B. Rechteck zeichnen, Rechteck markieren, Button "ausgewähltes editieren",  
 
Texturdatei: C: > Programme > PCCrashXX > examples > textures 
 

 
 
Texturdatei laden, z. B. water09.jpg 
Wasseroberfläche wird nur in 3D-Ansicht dargestellt 
 
z. B. Bildhintergrund mit Wald: Rechteck senkrecht stellen 
 
auch Ausschnitte der Bildtexturen sind möglich 
 
 
2.31 Simulation allgemein 
 
Vorgesehene Bremsverzögerung (z. B. 8 m/s2) kann in den Sequenzen nicht eingegeben werden (reduziert 
sich automatisch): 
 
- µ erhöhen 
 
- wegen Bremskraftverteilung Schwerpunktlage absenken 
 
dann in den Sequenzen Bremsverzögerung entsprechend erhöhen 
 
oder kinematisch rechnen 
 
  



 

 

2.32 Rückwärtssimulation und Synchronisation, z. B. Lkw-Gespann 
 
Ab der Version 13.0 über eine „Schleppkurve“ möglich: 
 
Es handelt sich um eine kinematische Berechnung. Nur für ungelenkte Anhänger! 
 
Fahrzeuge laden, Anhänger koppeln, Sequenzen vorgeben, Pfad für Spurverfolgung für das Zugfahrzeug und 
den Anhänger vorgeben, für ein optimales Ergebnis auf „Mitte Hinterachse“ stellen. Das Gespann folgt der 
Spur des Anhängers. 
 

   
 
Dann das Fahrzeug rückwärts fahren lassen (Rückwärtssimulation), fertig 
 
 
2.33 Einlaufsequenzen aus digitalem Tachographen übernehmen 
 
Die Daten werden als *.ddd – Datei abgespeichert (z. B. auf CD). Es kann nur mit einem entsprechenden 
(speziellen) Programm darauf zugegriffen werden (ab der PC-Crash-Version 14.0 können diese *.ddd-
Dateien direkt eingefügt werden) Beispielausdruck: 
 

 
 
Bei älteren Versionen: 
Um die Daten (Zeit und Beschleunigungen) in´s PC-Crash übernehmen zu können, müssen diese als 
Textdatei (*.txt) vorliegen. Hierzu zunächst *.ddd – Datei z. B. bei der Polizei (oder mit eigener Software des 
Herstellers DAKO, www.vehicleunit.de) auslesen und als WORD-Datei abspeichern. Beispiel: 



 

 

   
 

 
 
 
WORD 2003: WORD 2013: 

      
 
Bei Abfrage: 3 Spalten, Trennen bei „Semikolons“ 

 
Das können mehrere Seiten sein. Den 
relevanten Bereich, z. B. 20 m vor der 
Kollision, belassen und den Rest löschen 

Alle Daten markieren, Text in Tabelle wie 
folgt umwandeln 
 



 

 

 
 
 
Folgende Abfrage mit OK bestätigen 
 

 
 
Spalte Datum / Zeit leeren, in diese Spalte die Zeit beginnend ab „0“ aufsteigend einfügen (oder in 
nachfolgender Excel-Tabelle ändern), abspeichern (im Beispiel Aufzeichnung mit Abstand 1 s, bei ¼ s dann 
0 – 0,25 – 0,50 – 0,75 usw): 
 

 
 
Excel-Vorlage aus ….PCCrash10x > Examples > Tachograph data, „velocity & distance 20131101.xls“ (für ¼ 
s:„velocity & distance 20160310.xls“ unter PCCrashxx > Examples) öffnen (dort sind Berechnungsformeln 
hinterlegt): 
 

Tabelle speichern als *.txt 

 
 



 

 

 
 
Daten aus angefertigter Tabelle (nur die beiden ersten Spalten! Und alle Zeilen! Im Beispiel auch Zeile 38) in 
den grau markierten Bereich übertragen (kopieren und einfügen), 
die Zeilen unterhalb des eingefügten Bereiches (im Beispiel ab Zeile 38) löschen 
 

 
 
Wenn Time positiv, im PCCrash zur Vorwärtssimulation nutzbar, wenn Time negativ, Rückwärtssimulation. 
Negative Werte können im Excel einfach umgewandelt werden, indem z. B. der höchste negative Wert in der 
oberen Zelle hinzu addiert wird, dann auf darunter liegend Zellen übertragen 
 
Die Zeilen in denen keine Spaltenwerte eingetragen sind (im Beispiel C38, D38, E38), die darüber liegende 
Zelle markieren und am rechten, unteren Eck in die darunter liegende Zelle ziehen (die entsprechende Formel 
wird dann reinkopiert) 
 



 

 

 
 

 
 
 
Dann: Fahrdynamik > Sequenztabelle > Bremsen/Beschleunigen 

 
 
Symbol oben links: rechter Mausklick > „Load Data…“ 

 
 

Excel-Daten aus Spalten G und H mit 
Kopfzeile (Zellen G1 und H1) in 
Textdatei kopieren (*.txt), hierzu z. B. 
Windows-Editor verwenden (Windows-
Start-Taste > Zubehör > Editor), 
einfügen, speichern als *.txt. 

Zum Öffnen: Pfad der kopierten 
Textdatei angeben 



 

 

Die Sequenztabelle hat Priorität gegenüber den eingegebenen Sequenzen. 
 
Wenn Anhänger vorhanden: gleiche Sequenztabelle ebenfalls einfügen 
 

 
 
In „Sequenzen“ Bremssequenz mit ausreichender Dauer und Startgeschwindigkeit vorgeben. 
Startgeschwindigkeit der Tabelle entnehmen (im Beispiel 24 km/h) 
 

 
 
Im Fenster „Sequenztabelle“ auf „Simulation“ drücken oder Vorwärtssimulation wie üblich. 
 
 
Wenn Tachodaten aus der Sequenztabelle verschwunden sind: 
Tachodaten *.txt erneut laden (das passiert insbesondere, wenn die Sequenz kürzer als die Sequenztabelle ist 
oder das Simulationsabbruchkriterium zu kurz ist). 
 
Wenn das Fahrzeug zunächst in die falsche Richtung fährt (z. B. bei der Rückwärtssimulation), zuerst 
vorwärts simulieren und dann den Vorwärtspfad sperren.  
 
 
 
 
 

  

Simulationsabbruchkriterium: „Sequenztabelle“ 
(Ampelsymbol) oder „max. Simulationszeit“ 
ausreichend (ca. 1 s länger als Sequenztabelle) 
eingeben 



 

 

2.34 Endlagen oder Zwischenpositionen löschen 
 

Stoßparameter optimieren, Einstellungen, Fahrzeug 
auswählen, "Endlagen" (bzw. „Zwischenpositionen“) 
auswählen, Position löschen 
 

 
 

2.35 zeitliche Vermeidbarkeit simulieren 
 
Spurpunkte vorgeben: Fahrdynamik > Spurpunkte definieren 
 
Ausgehend von Kollision, zunächst Rückwärtssimulation berechnen (=Einlauf berechnen), mit dem 
Schieberegler (Zeitschieber) Fahrzeuge auf den Reaktionspunkt stellen, 

„Neuen Startpunkt festlegen“  (t = 0.000 s), 
Sequenzen anpassen (Startpunkt nach oben schieben, ggf. Verzögerung und Weg Fzg 2 anpassen, 
Ausgangsgeschwindigkeiten anpassen), Kontrolle durch Vorwärtssimulation 
 

Stoßerkennung ausschalten:  
 
Empfehlung: nicht beteiligte Fahrzeuge, auch MKS, löschen (nicht nur deaktivieren), sonst könnte es dennoch 
zu rechnerischen Kollisionen mit diesen Fahrzeugen kommen 
 

> Simulation > zeitl. Vermeidbarkeit  
 
 
 
 
 
 
 

 

 



 

 

 
 
 
Alternativ: Kinematik-Toolbar verwenden, siehe Benutzerhandbuch 4.3.8.2 
 
 

2.36 Kinematik-Toolbar, Einlauf- und Auslaufbewegung simulieren 
 
zunächst Stoß und Auslauf berechnen 
 
Für Einlaufbewegung: Pfad (Spurpunkte) vorgeben 
 

 
 
 
  

Kinematik-Toolbar: Werte eingeben (wie 
bei 2.23) 
 
Button „Diagramme“ anklicken (wie bei 
2.23) 
 
Button „kopieren“ anklicken, die Werte 
werden dann in die Zwischenlablage 
kopiert und können direkt in das 
Gutachten kopiert werden 
 
Die Vermeidbarkeit ist beim Fahrzeug 1 
enthalten 

Vermeidbarkeitsfahrzeug auswählen,  
Ausgangsgeschwindigkeit eingeben, 
„Geschwindigkeit reduzieren“ 
 
Eventuell Punktwolke oder Mesh-Modell 
löschen, damit die Berechnung schneller geht 
 
> Berechnen 
 
es wird dann so lange simuliert, bis keine 
Kollision mehr stattfindet 



 

 

2.37 Benutzerdefinierte Fahrzeugpositionen 
 
mit dem Schieberegler in die gewünschte Position fahren 
 
Button: Ansicht > „aktuelle Fahrzeugposition in Anzeigeliste aufnehmen“    
weitere gewünschte Position aufnehmen 
 
ggf. Button drücken „Fahrzeuganzeigeliste bearbeiten“     
evtl. Zeiten abändern, Position wird automatisch berechnet 
Bezeichnung eingeben, z. B. 1 s vor der Kollision 
(Bezeichnung wird derzeit noch nicht angezeigt) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2.38 Zweites Ansichtsfenster 
 
 

 

> Ansicht > Ansichtsfenster > z. B. „Zwei: Vertikal“ 
 

 

Dann z. B. andere Ansicht im zweiten Fenster darstellen 

 

 

Grundeinstellungen > Fahrzeuge > 
„benutzerdefinierte Fahrzeugpositionen“ anklicken 

 



 

 

 
2.39 EES-Ermittlung aus Deformationslinien / EBS-Berechnung 
 
(EBS = Energy Barrier Speed, = EES ohne Restitution) 
Fahrzeug > Fahrzeug-Dxf… > Zeichnung bearbeiten 
 

 
 

 
 

 
 

 
 

 
 

Deformationslinie einzeichnen 
(als normale Polylinie) 

 

Fahrzeug-Umrisslinie muss vorhanden 
sein, sonst wie nebenstehend erzeugen 
 

Rechtsklick auf Polylinie, als 
Deformationslinie definieren 

Dxf-Fenster schliessen, 1x neue 
Simulation anklicken, deformierte Fläche 
wird schraffiert dargestellt und in EBS-
Berechnung übernommen 



 

 

richtiges oder vergleichbares Fahrzeug auswählen, Anstoßrichtung ( = PDOF, siehe Pfeil) beachten,  
Frontanstoß: PDOF = 0° 
Heckanstoß: PDOF = 180° 
Seitenanstoß: PDOF = 270°, usw. 
 

  
 

Achtung: 
Wenn hier keine Werte angegeben sind, ist das ausgewählte Fahrzeug nicht verwendbar 

                                (Speed = 0, dann anderes Fahrzeug auswählen) 
 

 
 
 

2.40 EBS-Berechnung ohne Deformationslinien: 
 
Deformationen eingeben: 

   
 
ggf. Stoßrichtung eingeben, EES bzw. EBS ablesen: 
 
 

! ! 

„Übernehmen“ anklicken 

Auswahl „EBS“ anklicken, EBS und EES kann 
abgelesen werden, EES variiert je nach k-Faktor, 
 
(beim dargestellten Deformationsschaubild, auch 
bei der Auswahl „Deformation“ handelt es sich 
lediglich um symbolische Zeichnungen) 



 

 

 
2.41 EES – CNN (neuronales Netzwerk) 
 
Es handelt sich um ein neuronales Netzwerk bzw. KI (künstliche Intelligenz). Zum Anlernen der KI wurden bisher 
(25.9.2020) Vergleichsbilder aus Recon-Data herangezogen. Es eignen sich deshalb vorwiegend 
Schrägaufnahmen des Schadenbereiches, da hier die Eindringtiefe besser verifiziert werden kann. Aufnahmen 
etwa im 90°-Winkel zum Schadenbereich sind deshalb ungeeignet. Fotos können beschnitten werden, um 
störende Bildinhalte oder andere Fahrzeuge auszublenden.  
 
Es ist vorgesehen, dass zum Anlernen der KI weitere Daten aus anderen Crashversuchen Verwendung finden. 
Für schwere Lkw´s ist dieses Verfahren ungeeignet, da das EES auch für geübte Sachverständige ohnehin 
kaum abzuschätzen ist. Zudem liegen nur wenige, aussagekräftige Vergleichsbilder vor. 
 

   
 
 
In dieses Fenster per „Drag and Drop“ ein oder mehrere Schadenfotos einfügen, Ergebnis bei z. B. 3 Bildern: 
 

 
 
Es können einzelne Bilder ausgeblendet oder gelöscht werden. Die Anzeige (EES-Estimation) zeigt dann 
jeweils nur die die Ergebnisse der eingeblendeten Fotos an. Mit dem Button „EES Katalog“ (rechts oben) kann 
direkt in ReconData gewechselt werden. 
 



 

 

Den EES-Wert dennoch kritisch prüfen! 
 
  



 

 

Durch einen Doppelklick auf das jeweilige Foto wird eine farbliche Kennzeichnung eingefügt. Die rote 
Hervorhebung zeigt den für die EES-Abschätzung herangezogenen Bereich an. Wenn dieser außerhalb des 
Hauptschadenbereiches liegt, ist die EES-Abschätzung nicht zutreffend. 
 

 
 
EES-Abschätzung aus dem Hauptschadenbereiches erscheint zutreffend  
 
Das EES – CNN interpretiert z. B. demontierte Scheinwerfer oder offene Türen als Löcher infolge der 
Kollision. Hieraus resultiert eine zu hohe EES-Abschätzung. 
 



 

 

2.42 Rangiermanöver / Ausparkvorgang rückwärts 
 
Rangieren: 
Sequenzen eingeben, Sequenzlänge in Sekunden, nicht in Meter (ist ohnehin leichter zu handhaben. 
Außerdem endet Sequenz nie, wenn z. B. Sequenzlänge 3 m eingegeben worden ist und das Fahrzeug vorher 
wegen einer Bremsung zum Stillstand gelangt. Die Simulation endet dann, obwohl eine weitere Sequenz 
eingegeben worden ist) 
 

   
 

   
 
Darstellung im Weg-Zeit-Diagramm: 
Optionen > Diagramme > x-Achse           Zeit 

     
 
 
Oder: 
Lenksequenzen einzeln über Sequenztabelle vorgeben 
 
 
Rangiervorgang mit Stillstandszeit: 



 

 

 
 
 
 
 
 
  

Button „Ampel“ Simulationsabbruchkriterium 
„manuell“ anklicken 
 



 

 

Ausparken rückwärts: 
 
 Pfad für Spurverfolgung vorgeben 
 Simulation > Fahrdynamik > Basiswerte 

 
 
 
In den Sequenzen vor „Start“: 
Bremssequenz und  
Beschleunigungssequenz  
Vorgeben (für Rangiervorgang), 
z. B: 
 
 
 

 
 
Wichtig:  
für ausparkendes Fahrzeug Geschwindigkeit (mind. 0,5 km/h) vorgeben, sonst fährt es in die falsche Richtung. 
 
 

Haken bei „Copy“ rausnehmen 
NY um 180 Grad verdrehen 

 

Dann Fahrzeug vorwärts fahren lassen 



 

 

2.43 Anhängerkopplung 
 
Deichsellänge = ab Vorderachse Anhänger 
Überstand Anhängerkupp.: bezogen auf Fahrzeugumriss hinten,  
d. h. bei - 0,1 m ist die AK 0,1 m innerhalb des Fahrzeugumrisses 
 
Wenn Gelenksteifigkeit Sattelkupplung berücksichtigt werden soll: 

 
Achse auswählen, z. B.: 
x-Achse = Fahrzeuglängsachse (Wanken) 
Phi 0 = 0,            (Anfangsauslenkung) 
Phi min = 5°,       (Freigängigkeit innerhalb +/- 5°) 
S0 = 0 Nm/°,       (Anfangsgelenksteifigkeit, üblicherweise ca. 0, 
                           damit kräftefrei) 
S = 4000 Nm/°,   (Gelenksteifigkeit pro Grad Verdrehung. Übliche 
                            Werte: x-Achse 3000-5000 Nm/°,  
                            y-Achse: 3000-5000 Nm/°, z-Achse: 0 Nm/°) 
 
y-Achse = Fahrzeugquerachse (Neigen) 
Phi 0 = 0 
Phi min = 15° 
S0 = 0 Nm/° 
S = 4000 Nm/° 
 
z-Achse = Fahrzeughochachse (Gieren) 
Phi 0 = 0 
Phi min = 0° (beliebig, da S = 0 Nm/°) 
S0 = 0 Nm/° 
S = 0 Nm/° 
 

 
2.44 Sonnenstand eingeben / Schatten berechnen 
 
Nur berechnen, nicht für 3D-Darstellung: 
Optionen > Sonnenstand 
 

 
 
 
 
 
 
 
Achtung:  
die Richtung der Sonneneinstrahlung wird im Diagramm rechts unten durch den roten Punkt 
angezeigt! (rote Linie im linken Diagramm: = Uhrzeit) 
 
Ab PC-Crash 14.0: Koordinaten für den Sonnenstand aus „Extras/Mapping/GPS...“ übernehmen: 
 
Rechte Maustaste im Fenster „Map“:> Sonnenstand > Datum, Uhrzeit und ggf. Sommerzeit eingeben, wird 

 

 

Land und Ort eingeben 
Datum und Uhrzeit eingeben 
Sommerzeit ggf. anklicken 
Berechnen 
(nach der Eingabe des Ortes auf 
http://maps.google.com klicken, dann 
wird die Position angezeigt) 



 

 

dann übernommen, zur erneuten Ansicht im PC-Crash: Extras > Sonnenstand anklicken 
 
 
Sonnenstand im 3D-Fenster, für Schattendarstellung: 
 
 
 
 
3D-Fenster öffnen, z. B. mit „F9“ 
 

Button „Lichtquelle positionieren“ anklicken   
 

Wichtig: Lichttyp auf „gerichtet“ umstellen 
(geht künftig automatisch, wenn Button 
„Sonnenstand“ angeklickt wird) 

 

Button „Sonnenstand“  anklicken (Sofern nicht 
bereits aus „Extras/Mapping/GPS...“ (siehe oben) 
übernommen 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

„Berechnen“ anklicken, Button  anklicken (wird erst dann übernommen) 
 
 
3D Darstellung > Darstellung > Anzeige Optionen > Schatten > „Schatten berechnen“ aktivieren 

 

Land auswählen,  
 
Stadt auswählen,  
 
Datum und Uhrzeit eingeben 
 
ggf. Sommerzeit anklicken,  
 



 

 

 
 

 
Es wird nur der Schatten an den 3D-Modellen berechnet, nicht der Schattenwurf  
durch die 3D-Modelle oder beim Mesh.  
 
  

 

! ! 



 

 

 
2.45 Diagramme filtern 
 
Diagrammfenster öffnen, z.B. mit „F2“ 

      
 
CFC-Filter, z. B. 60:    Grenzfrequenz 60 Hz, Frequenzen über 60 Hz werden eliminiert. 
 
 
  



 

 

3. Zeichenprogramm 
 
Ellipse zeichnen:  
Über die Eingabearten Achse, Endpunkt - Achse, Mittelpunkt - 2 Eckpunkte kann eine Ellipse gezeichnet 
werden 
 
3.1   3D-Darstellung allgemein 
 
Berührebene in 3D-Darstellung anzeigen: 

 
 
3D-Karosserieform ändern (nur bei Pkw): 
Fahrzeugdaten > Karosserieform 
 
3D-Dxf Höhenlage für Simulation ändern: 
 

 
 

 
 
 
3D-Dxf ist zu groß: 
Fahrzeuglänge in den Fahrzeugdaten (Fahrzeug > Fahrzeugdaten… > Länge) anpassen (das 3D-Dxf wird 

Geschwindigkeitsdreieck (v-Dreieck) einschalten, 
Berührebene wird dann angezeigt 

Sequenz 
„Geometrieveränderung“ 
eingeben 
 

An alle vier z-Achsen z. B. z = 0,1 m eingeben, 
die Räder werden dann um 10 cm angehoben,  
 
Button „Vorwärtssimulation“ drücken, das 
Fahrzeug „fällt“ dann bei der Simulation 10 cm 
runter, benötigt ca. 1,5 bis 2 s zum 
Ausschwingen 



 

 

automatisch nach der Fahrzeuglänge skaliert) 
 
3D-Dxf Abmessungen ändern / skalieren: 
Fahrzeug > Fahrzeug-Dxf… > Datei… > 3D Darstellung > Abmessungen 
3D-Dxf wird dann „gestaucht“ oder „gestreckt“ 
 
3D-Dxf liegt zu hoch oder zu tief: 
Fahrzeug > Fahrzeug-Dxf… > Datei… > 3D Darstellung > Abmessungen > z-Achse 
Höhe (= z-Achse ) anpassen, z.B. Pkw ca. 1,4 m 
(Oberkante 3D-Dxf entspricht Fahrzeughöhe) 
 
3D-Fenster verschieben: 
Entfernung verändern: Strg + linke Maustaste 
Kamerawinkel verändern: linke Maustaste 
Kamerahöhe verändern: Shift + linke Maustaste 
 
3D-Dxf: 

Art Qualität Geeignet für 3D-Kontaktberechnung 
DirectX *.enc ist sehr detailliert ja, jedoch nur *.dxf nicht *.enc 
FCE  nein, nur für Optik, mittlerweile ohnehin 

veraltetes Format 
idf  nein, nur für Optik, mittlerweile ohnehin 

veraltetes Format 
x61 wenig detailliert ja, schnell bei Berechnungen 

 
3D-Dxf ändern 
*.enc kann mit hierfür geeigneten Programmen bearbeitet werden, z. B. „Blender“ oder „PDF24“ 
 
Hinweis: 
Eine Berechnung mit einem Mehrkörpersystem kann mit einem x61 – 3DDxf durchgeführt werden. Dann 
(nach der Berechnung, nicht auf Startposition zurückgehen) z. B. DirectX – 3DDxf laden. Die 3D – 
Darstellung und auch ggf. die Videoanimation ist dann sehr detailliert. 
 
Bei x61-Dateien sind die Radläufe offen, es können deshalb rechnerische Verhakungen stattfinden, dann 
DirectX anstatt x61 laden. 
 
Das Format DirectX ist sehr detailliert, auch der Innenraum, jetzt auch für den 3D-Kontakt geeignet, *.enc und 
*.dxf des jeweiligen Fahrzeuges laden, dxf-Kontakt im MKS (Mehrkörpersystem) aktivieren. 
 
 
  



 

 

Radpositionen des 3D-Modells verwenden: 
 

 
 
System stürzt ab, z. B. mit Mehrkörpersystem und 3D-Dxf: 
(im vorliegenden Fall mit einem Fahrrad),  
 

 
 
 
3D-Dxf verschwindet während der Simulation im Boden: 

 
Überschlagserkennung einschalten 
 
 
 
 
3D-Dxf wird nicht im 3D-Fenster angezeigt: 

 
3D-Ansicht aktivieren: 

 

Es handelt sich um ein Problem mit 
dem 3D-Dxf.  
 
Abhilfe: zuerst simulieren (rechnen), 
dann erst 3D-Dxf laden. 
 
 



 

 

  
 
 
 
Fahrzeuge sind in der 3D-Darstellung überlagert: 
 

 
 
Eingezeichnete Spuren sind in der 3D-Ansicht versetzt: 
 
Wenn auf einem Neigungspolygon bzw. auf einer geneigten Fahrbahn Spuren z. B. mit einer Breite von 18 cm 
eingezeichnet werden, so erscheinen diese in der 3D-Ansicht versetzt bzw. verschoben. Breite Linien werden 
im 3D-Fenster derzeit nur zweidimensional dargestellt, deshalb verläuft die Linie bzw. Spur nicht auf der 
geneigten Fahrbahn, sondern horizontal und erscheint deshalb verschoben bzw. versetzt. 
 
 
3D-Dxf ab der Version 9.0: 
 
ab der PC-Crash-Version 9.0 können 3D-Dxf´s eingefügt werden, ohne dass hierfür ein Fahrzeug geladen 
werden muss. Hierzu das gewünschte 3D-Dxf aus der Explorer-Toolbar in die Zeichnung ziehen. Zum 

Markieren (vorher Markierungs-Button  drücken) das 3D-Dxf am Rand anklicken. Im 3D.dxf 
erscheint dann ein blaues Quadrat. Die Größe, der Verdrehwinkel usw. können dann über die Button´s 
„ausgewähltes skalieren 3D“, „ausgewähltes rotieren 3D“ usw. eingestellt werden. 
 
  

Tritt dann auf, wenn zuerst „Mesh-Modell“ angeklickt 

worden ist und dann erst das 3D-Dxf installiert 

wurde. Abhilfe: zuerst 3D-Dxf laden, dann erst bei 

Stoß > „Mesh-Kontaktmodell verwenden“ anklicken 



 

 

 
3.2 Teile, z. B. Außenspiegel an 3D-Dxf anfügen 
 
Fahrzeug laden 
3D-Dxf laden (nicht: *.enc) 
Fahrzeug > Fahrzeug-Dxf > Zeichnung bearbeiten 
Mit Polylinie Spiegelrahmen zeichnen 

 
 
 
ausgewähltes verschieben 3D, z. B. 1 m nach oben  
 
 
ausgewähltes extrudieren z-Achse, z. B. 0,2 m 
fertig 
 
Siehe auch: Benutzerhandbuch Kapitel 13.5.2.1 
 
3.3   3D-dxf-Anbauteile an Fahrzeuge einfügen 
 
z. B. Pflug an Ackerschlepper: 
 

           
 

Daten Ackerschlepper laden: 
Explorer Toolbar > Fahrzeugdaten > Objects > 
Tractor > „Tractor.dat“ laden 

 

 



 

 

  
 
> Zeichnung bearbeiten 
Dann die einzelnen Fahrzeugkomponenten (3D-dxf´s Ackerschlepper und Pflug) in die Zeichnung ziehen. 
 

 
 

 
 
Anschließend die einzelnen Fahrzeugkomponenten (3D-dxf´s Ackerschlepper und Pflug) markieren (auf 
äußere Umrisslinie klicken), Größe anpassen („ausgewähltes skalieren“) und ausrichten, in 3D-Ansicht prüfen 
 

Dann: Fahrzeug > Fahrzeug-Dxf… > 
Fahrzeug Zeichnungen > „Neu“ 
anklicken,  
 



 

 

 
 
Ggf. für Stoßerkennung: 
Zeichnung bearbeiten, alles markieren, Umrisslinie erzeugen 
 

 
 

 
 
Es wird hierdurch eine Umrisslinie um den Ackerschlepper (roter Fahrzeugumriss) erzeugt, nicht um die 
Anbauteile. Den roten Fahrzeugumriss zweimal anklicken, dann erscheint die Umrisslinie 
 

 
 

Den roten Fahrzeugumriss zweimal 
anklicken, dann erscheint die Umrisslinie 



 

 

 
 
 
 
  

Die Eckpunkte nach außen auf die 
Umrisse der Anbauteile ziehen, es 
können Punkt eingefügt oder auch 
gelöscht werden. 
 



 

 

3.4   3D Straßenobjekt / Triangulation 
 
Kurvenverlauf über Spurpunkten: 
 
Spurpunkte für Fahrzeug 1 definieren (nur für den Fahrbahnverlauf, wird wieder gelöscht) 
 

3D Straßenobjekt anklicken    
Radienverlauf der Fahrbahn: „Spurpunkte verwenden“ 
 
Böschungen eingeben (siehe oben)              negative Werte = abfallend 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Verlauf: z. B. Gefälle 5 % 
Diagrammauflösung z. B. 100m (dann im Beispiel nur ein Wert einzugeben, gleichmäßiges Gefälle) 
Doppelklick auf Diagrammlinie 
 

 
 
bei z. B. 5 % Gefälle, y1 = 5m eingeben 

 

 
Achtung: keine Linie unter 0 

Fahrbahn erforderlichenfalls anheben, 
über „Höhenverlauf“ ! 

 

! 
 

z. B. Graben neben Fahrbahn: 
bei Verlauf: nicht „Höhenverlauf“, 
sondern „Böschungsprofil“ auswählen 



 

 

 
 

Ändern: Auswahl über Button „Neigungspfeil“  nicht „Markierungspfeil“  
 
Böschungsprofil eingeben: 
 

Button Böschung auswählen  Doppelklick auf Böschung zum Bearbeiten 
 

 
 

Zuerst Böschungen eingeben, Werte 
beispielhaft, damit im folgenden Fenster 
das Böschungsprofil erscheint, 
 
dann „Böschungsprofil verwenden“ 
anklicken 



 

 

 
 
In den Karteireiter „Verlauf“ wechseln, „Böschungsprofil“ auswählen, den Graphen für links oder rechts 
anklicken, die Punkte verschieben (anpassen) 
 
Horizontale Skala: „0.0“ entspricht dem Fahrbahnrand, Böschungsverlauf nach rechts ist blau dargestellt (nach 
links rot), jeweils ausgehend vom Fahrbahnrand 
 
 

manueller Kurvenverlauf: 
 

3D Straßenobjekt anklicken    
 

erneute Auswahl über Button „Neigungspfeil“   

(nicht „Markierungspfeil“  ) 
 
Straßenverlauf, Höhenverlauf und Böschung oder Böschungsverlauf eingeben, 
bei Böschungsverlauf kann nur entweder eine Seite eingegeben werden oder beide Seiten spiegelbildlich 
 
Böschung oder Berg durch Zeichenprogramm erstellen: 
 
z. B. Berg: 

geschlossenes Polygon zeichnen (z. B. äußerer Umriß des Berges)  
innerhalb dieses Polygones ein kleineres Polygon zeichnen (z. B. Berg oben) 
inneres Polygon markieren, Button "3D verschieben" anklicken, z. B. Höhe: z = 5 m 
beide Polygone auswählen 
Button "ausgewähltes triangulieren" 
Abfrage: „soll die triangulierte Fläche als Neigungspolygon übernommen werden?“          ja 
in 3D-Ansicht ist der Berg ersichtlich 
 
 
z. B. Kreisverkehr: 
1. Kreisverkehr als Polylinie zeichnen (Kreis geht nicht!) 
2. innere Überhöhung Kreisverkehr als Polylinie zeichnen (oder kopieren und verkleinern) 



 

 

3. Busch innen als Polylinie zeichnen 
4. innere Überhöhung markieren, ausgewähltes verschieben 3D, z. B. z=0.8 
5. Busch innen markieren, ausgewähltes verschieben 3D, z. B. z=1.2 
6. alles markieren, ausgewähltes triangulieren 
 
z. B. Böschung neben Fahrbahn: 

Polylinie entsprechend Straßenverlauf zeichnen (nicht: Ecken abrunden)  
Polylinie kopieren und verschieben (wegen gleicher Anzahl Punkte), ggf. Punkte der Polylinie anpassen 

innere Polylinie markieren, verschieben 3 D:  
z. B. z = - 2 m  

beide Polylinien markieren, triangulieren:   
 
erforderlichenfalls: Triangulationsabstand eingeben (wenn Triangulationspunkte nicht berücksichtigt werden) 
 

 

Min. – Max. Triangulationsabstand 
eingeben, z. B. 0,05 m bei kleinen 
Objekten (z. B. zwei Rechtecke), 
oder z. B. 0,5 m bei der gesamten 
Skizze 



 

 

   
 
Abfrage: „soll die triangulierte Fläche als Neigungspolygon übernommen werden?“          ja 
(damit sind Böschungsflächen definiert) 
Abfrage: „sollen die bestehenden Neigungspolygone gelöscht werden?“          ja 
 
Falls ein BMP eingefügt wurde, wird dieses automatisch markiert. Markierung belassen, dann wird das BMP 
geneigt 
 
Es können auch mehrere Polylinien markiert und trianguliert werden. 
 
Wenn Unregelmäßigkeiten (Vertiefungen in der 3D-Darstellung) im Böschungsprofil vorliegen:        

 
 
In der Draufsicht rechte Maustaste auf schwarze Linienteile           



 

 

 
 
         Punkte an Schnittlinien rot/schwarz einfügen, alles mit Markierungspfeil markieren, neu 
         triangulieren. 
 
 
Weiteres Beispiel bei Unregelmäßigkeiten: 

    
 

 
 
wenn bei der Simulation Fahrzeuge durch die Böschung fallen: an Schnittpunkten der Dreiecksflächen 
zusätzliche Punkte auf der Polylinie einfügen, erneut triangulieren 
 
Für Videoanimation: im Fenster Refresh: Neigungspolygone deaktivieren,  
Darstellung Wiese ausschalten, in 3D Darstellung:  
 

     

 



 

 

 
Neigungspolygon löschen: 
 

Auswahl über Button „Neigungspfeil“  nicht „Markierungspfeil“  
Neigungspolygon markieren, löschen (Taste „Entfernen“) 
 
 
 
 
 
 
  



 

 

3.5   3D-Insassen-Zeichnung (nicht: MKS) einfügen 
 
Wird zusätzlich zur 3D-Zeichnung (3D Fahrzeug bzw. 3D-Dxf) des Fahrzeugmodells geladen.  

    
 
Fahrzeug > Fahrzeug-Dxf... > Neu > Neu#1 markieren > Zeichnung bearbeiten 
Es erscheint der rechteckige Fahrzeug-Umriss (weil „Neu#1“ aktiv ist), die Insassen (beliebig viele) von der 
Explorer-Toolbar (3D-Fahrzeuge > DirectX > human > occupants > *.enc) per Drag and Drop in den Umriss 
einfügen (dauert etwas). 
 

 
 

 
 

Derzeit sind nebenstehende 
3D-Insassen verfügbar 



 

 

Die Insassen können im Fahrzeug verschoben werden. Damit die Insassen einfacher im Fahrzeug positioniert 
werden können, nochmal die Fahrzeug-Zeichnung laden und in einen gesonderten Layer verschieben. Hierzu 
das 3D-Fahrzeug (*.enc) per Drag and Drop in einen freien Bereich der Zeichnung (nicht in das geladene 
Fahrzeug) einfügen. 
 

 
 
Neuen Layer erstellen, z. B. „Car“, das Fahrzeug in diesen Layer verschieben. Dieses Fahrzeug („Car“) auf 
den geladenen Fahrzeug-Umriss verschieben. 
 
Insassen skalieren, in der Seitenansicht Höhe anpassen 
 
 
3.6 3D-Dxf laden (Bäume, Häuser ......) 
 
3D-Modelle einfügen: 
 
Häuser, Bäume usw. aus der Explorer-Toolbar (*.enc) in die Zeichnung ziehen, z. B. Größe anpassen: 
 
Ausgewähltes rotieren 3D und / oder skalieren 3D (Button „Ausgewähltes Drehen“ geht nicht) 
 
(3D-Dxf-Files, Katalog siehe Anhang) 
3.7 Google Earth Einstellungen /Skalierung 
 
Skalierung der Bitmaps ist standardmäßig nicht ideal. Ursache: Neigungen werden in Google Earth mit 
berücksichtigt:  
 



 

 

 
 
Im Kartenausschnitt von Google Earth wird in der Fußzeile Mitte rechts das Jahr der Luftbildaufnahme 
angezeigt. Dieses kann durch Anklicken der Jahreszahl links unten verändert werden 
 
 

3.8 Google Earth Höhenprofil 
 

 
 
„Höhenprofi anzeigen“ auswählen, mit der Maus dann den Pfad eingeben > Höhenprofil wird in einem neuen 
Fenster unten angezeigt 
 
 
 
 
 
  

Abhilfe: 
 
Tools > Optionen > 3D-
Ansicht >Gelände > 
Höhenverstärkung  
 
> auf 0.01 stellen 
(Standardwert ist 1) 

Das Höhenprofil in Google Earth 
stimmt gut, Neigungen können für 
die Unfallsimulation verwendet 
werden 
 
 



 

 

3.9 Bitmap aus Google Earth direkt laden / Mapping GPS 
 

 
 

 
 

 
 

Extras >Mapping/GPS... > 
suchen 
 

Ort eingeben (auf die Lupe 
klicken, nicht auf den Pfeil nach 
unten) 
 
 

Kartenauswahl > „Google“ oder „Bing“ 
 
Vergrößern > Übernehmen 
 
 
Es können danach zusätzliche, z. B. 
angrenzende Kartenausschnitte eingefügt 
werden 
 
> Kartenausschnitt in „Map“ entsprechend 
verschieben > Übernehmen 



 

 

 
 
 

 
 
Koordinaten für den Sonnenstand übernehmen: 
 
Rechte Maustaste im Fenster „Map“:> Sonnenstand > Datum, Uhrzeit und ggf. Sommerzeit eingeben, wird 
dann übernommen, zur erneuten Ansicht im PC-Crash: Extras > Sonnenstand anklicken 
 
 

  

Oder Eingabe über Koordinaten:  
über den Button „Suchen“, Koordinaten 
nicht direkt eingeben 
 
> Koordinaten: zuerst Breitengrad, dann 
Längengrad, z. B.: 
 
49.061462, 10.316043 
 
(wird in Google Earth in der Fußzeile rechts 
angezeigt) 

Oder aus Google Earth kopieren: 
 
Darstellung der Koordinaten umstellen 
auf „Dezimalgrad“: > Tools > Optionen  
 
> Bearbeiten > Ansichtsadresse 
kopieren ( = Mitte des Bildausschnittes) 
 
In „Map“ einfügen, °-Zeichen entfernen, 
Leerzeichen belassen 



 

 

3.10 Bilder mit GPS-Daten / Mapping GPS 
 

 
 
Ebenso können z. B. Daten aus einer GoPro eingefügt werden (mp4-file oder auch andere Formate) eingefügt 
werden. Der Pfad (z. B. eines Fahrrades) wird dann angezeigt. 
 
„Diagramme“  Geschwindigkeitsverlauf kann angezeigt werden 
 
Daten für die Simulation übertragen können als Sequenztabelle („Geschwindigkeit“) einem Fahrzeug 
zugeordnet werden. 
 
 
3.11 Google Maps 
 
Ist auch als Button im Google Earth hinterlegt 
 
 

3.12 Google Street View 
 
Eignet sich gut, um Sichtverhältnisse darstellen zu können oder z. B. Zeugenaussagen überprüfen zu können. 
Zunächst das Projekt auf einem 2D-Bitmap (z. B. aus Google Earth) rechnen. 
 
Google Chrome muss zwar installiert sein, es kann jedoch ein anderer Standard-Browser verwendet werden. 
 
Ansicht Street-View schnell und einfach: 

Extras > Mapping/GPS.... > rechter Mausklick auf „Sonnenstand“ > http://maps.google.com anklicken > 
Männchen rechts unten auf die Fahrbahn ziehen (sofern für diesen Fahrbahnbereich verfügbar, sind im Street 
View blau markiert) 
 
 

  

Extras \ Mapping/GPS… 
 
Wenn im Bild GPS-Daten enthalten 
sind:  Bilder per „Drag and Drop“ 
hineinziehen 
 
Die Aufnahmeposition wird dann direkt 
angezeigt 
 
Es kann in das Bild reingezoomt 
werden, „Übernehmen“ anklicken, der 
ausgewählte Bereich wird dann 
detaillierter dargestellt. 



 

 

3.13 Google Street View mit Hintergrundbild kombinieren 
 
Google Maps öffnen, aus dem Web-Store die (kostenlose) App „Pano Fetch“ laden 

 

 
 
Rechts unten wird dann ein Männchen angezeigt. 
 

 

Das Männchen in die Karte ziehen, wenn für den gewählten Ort Google Street View verfügbar ist, erscheinen 
die relevanten Straßen blau unterlegt. Dann Standort auswählen: 
 



 

 

 
 

 

Wenn der Mauszeiger über die Fahrbahn geführt wird, erscheint ein Pfeil, durch Verschieben kann der 
Standort verändert werden. 
 

 
 

Das Männchen befindet sich jetzt rechts 
oben. Anklicken, Qualität auswählen 
(Auflösung 3 ist ausreichend),  
die 360°-Bitmap wird dann in den Ordner 
„Download“ gespeichert 



 

 

 
 

 
 
Anpassen an ein Bitmap im PC-Crash ist derzeit noch aufwändig, soll jedoch vereinfacht (automatisiert) 
werden: 
 
Ansichten im Bitmap und Street View grob ausrichten, hierzu Transparenz verwenden, im 3D-Fenster > 
Darstellung > Anzeige Optionen > Hintergrundbild „im Vordergrund anzeigen“, „Wiese zeichnen“ einschalten, 
„Punkte für Kameraoptimierung“ einschalten 
 
im 3D-Fenster > Darstellung > Punkte für Kameraoptimierung > Hinzufügen, einige übereinstimmende Punkte 
einfügen,  
 
im 3D-Fenster > Darstellung > Kameraposition optimieren, 2D-Bitmap ausschalten 
 
 
360°-Bilder können auch selbst gefertigt werden, hierzu z. B. die Kamera Samsung Gear 360 (ca. 120,-- €) 
verwenden. 
 
  

In´s PC-Crash laden:  
im 3D-Fenster: > Hintergrund >  
„360° Bitmap öffnen 



 

 

3.14 Bitmap verbessern, Superresolution 
 

 
 
Bildauflösung wird verfeinert (Pixel werden interpoliert), bessere Darstellung 
 
 
3.15 Triangulation der Fahrbahn verlängern, 
 
Einfachste und beste Möglichkeit: 

  
 
 
 
 
 
  

Neigungspolygon einfügen und auf 
Fahrbahnniveau anheben (ZRef), 
Kontrolle im 3D-Fenster (siehe auch 
2.18) 



 

 

3.16 Tunnel (mit Beleuchtung) einfügen 
 
Explorer-Toolbar > 3D Fahrzeuge > DirectX > Misc > Tunnel > z. B. Tunnel01_right auswählen, mit Maus 
rüberziehen 
 
Lichtquellen an den Fahrzeugen 
einfügen 
 
In der 3D-Darstellung „Lichtquelle 
positionieren“ anklicken,  
Haken in Zeile 2 setzen (Zeile 1 ist 
standardmäßig die Sonne),  
für einen Schweinwerfer den Lichttyp 
„Spotlicht“ auswählen,  
Intensität z. B. 300 %,  
Haken bei „Lichtquelle hinter 
Kameraposition“ rausnehmen,  
„relativ zu“ (zum gewünschten 
Fahrzeug, im Beispiel „1 VW Passat“) 
auswählen,  
3D-Fenster so platzieren, dass das 
Fahrzeug in der 2D-Ansicht noch 
erkennbar ist,  

mit dem Button  die Lichtquelle 
dann z. B. auf dem rechten 
Scheinwerfer platzieren,  
Höhe einstellen, z. B. z= 0,6 m, 
Spotlicht Parameter Äußerer Kegel 
z. B. auf 90,0 ° einstellen 
 
 
Hintergrund dunkel, z. B. bei Nacht: 
3D Darstellung > Anzeige Optionen \ 
„Himmel zeichnen“ und ggf. „Wiese zeichnen“ ausschalten, 
Farbe Hintergrund auf schwarz oder dunkles grau einstellen 
 

 
 
Positionierung der Lichtquellen am Scheinwerfer im 3D-Fenster überprüfen und ggf. korrigieren, weitere 
Scheinwerfer in gleicher Weise einfügen 
 
ggf. weitere Lichtquellen einfügen, z. B. an der Decke 
 

 



 

 

3.17 Spurenlänge aus Foto ermitteln, mittels 3D-Fahrzeug 
 
Geht ab PC-Crash-Version 10.2 (wegen Punktewolke) 
 
Vorhandenes Bild, z. B. OS 2015, Fall 8: 

 
 
Die Abmessungen des Lkw Mercedes Atego werden als Referenzmaß verwendet, somit auch in z-Richtung 
 

1. 3D-Dxf des Mercedes Atego über die Explorer-Toolbar hereinziehen (Drag & Drop),  
nur 3D-Dxf laden, kein Fahrzeug laden!!!   

 

       
 

  

Die Länge dieser Auslaufspur soll 
ermittelt werden 



 

 

2. Kamera einschalten, Perspektive im 3D-Fenster etwa wie auf dem Foto 

     
 

 
3. Vorhandenes Foto als Hintergrundbild laden, aus dem 3D-Fenster 

    
 
4. Anzeige-Optionen einstellen 

 

     
 
Wichtig: „Wiese zeichnen“ ausschalten, sonst funktioniert Transparenz nicht 
 
5. Punkte für Kameraoptimierung einfügen 

 



 

 

  
 

   
 
dann Button „Hintergrundbild“ umschalten, den korrespondierenden Punkt im 3D-Dxf markieren (es wird 
„3D“ am Markierungspfeil angezeigt) 
 

 
 
Insgesamt mindestens 4 Punkte vorgeben, hierzu jedes Mal mit Button „Hintergrundbild“ zwischen BMP 
und 3D-Ansicht wechseln 
 

  

Zunächst Punkt im Hintergrundbild 
markieren, z. B. Mitte MB-Stern (es 
wird „BMP“ am Markierungspfeil 
angezeigt, Lupe verwenden)  
 

 



 

 

6. Kameraposition optimieren 

    
 
Die gewählten Punkte im Hintergrundbild und im 3D-Dxf liegen dann beieinander, Kontrolle über 
Transparenz (Schieberegler) möglich 
 
ggf. einzelne Punkte löschen und wieder einfügen oder weitere Punkte einfügen, erneut optimieren 
 
7. Kameraposition speichern 
 
Sonst kann die Kameraposition leicht versehentlich verschoben werden 

    
 
Kameraposition kann dann wieder abgerufen werden, hierzu im Kamerafenster dann den gewählten 
Namen auswählen 

 
 
8. Punktewolke laden 
Punktwolke per Drag & Drop aus dem Explorer ins Arbeitsfenster ziehen  
(….. PCCrash102\Examples\Laserscanner\10x10m1cm.xyz)  
 



 

 

 
 

Punktewolke markieren (mit Markierungspfeil ), etwa auf den relevanten Spurenbereich ziehen, 
Markierung beibehalten 

                    
 

  

Punktewolke in Symbolleiste auswählen, 
Button „Alles auswählen“ (Punktewolke 
wird gelb) 
 
 
 
Button „Auswahl neu einfärben“ drücken 
 



 

 

In den Zeichenbereich klicken, Spur ist dann entzerrt und kann ausgemessen werden. 
 

 
 
Dann können Fahrzeuge geladen werden und z. B. in der 3D-Ansicht auf die Spuren gestellt werden. Zur 
Bildoptimierung geladenes 3D-Dxf (nicht das Fahrzeug) ggf. wieder löschen. Es kann dann eine 
herkömmliche Kollisionsanalyse durchgeführt werden, wobei im vorliegenden Fall sowohl die Kollisionsort 
wie auch die Endstellung des Pkw Mazda durch die Spur dokumentiert sind. Das Hintergrundbild 
deaktivieren (3D-Darstellung\Darstellung\Anzeige Optionen\“Hintergrund Bild anzeigen“), Simulation kann 
dann im 3D-Fenster aus jeder beliebigen Perspektive betrachtet werden. 
 

 
 
  



 

 

3.18 Längen- oder Höhenmaßstab in Zeichnung einfügen 
 

 
 
 
3.19 Seitenansichten überlagern, z. B. Unfallflucht / Kompatibilität 
 
3D-Fahrzeuge laden, im 3D-Fenster erscheint dann jedoch perspektivische Darstellung. 
 
Besser: Button „Ansicht von vorne“ drücken, dann wird eine Parallelprojektion der Fahrzeuge dargestellt 
 

 
Vorher ggf. vertikalen Maßstab einfügen (siehe voriger Punkt) 
Mit Bitmaps aus PC-Crash (für transparente Darstellung): 
 
Datei > Importieren > Bitmap > „Verz PCCrashXX“ > Sidebmp > „Fzg. auswählen“ 
 

Explorer-Toolbar öffnen, „Symbole“ „Scales“  
anklicken, gewünschten Maßstab 
auswählen, z. B. „Scale vertical“ für 3D-
Darstellung, z. B. „Scale Spline“ für 
gebogenen Maßstab (hier kann die 
Gesamtlänge dann über den 
Bemaßungstext durch einen Doppelklick 
abgelesen werden) 
 
per „Drag and Drop“ in die Zeichnung 
ziehen 
 
weitere Maßstäbe befinden sich im Ordner 
„Symbole“ „Misc“   



 

 

 
 
Fahrzeuge skalieren (Bitmap skalieren) 
 

 
 
Fahrzeuge teilweise übereinander legen            das zuerst geladene Bitmap befindet sich im Hintergrund 

 
 
Transparenz für vorderes Fahrzeug erhöhen 
 

 
 
ggf. Fahrzeug neigen, z. B. -3 Grad 
 



 

 

                 
 
Ergebnis: 

 
 
 
3.20 Raster zur Ausrichtung von Zeichnungsobjekten verwenden 
 
Graphik: Zoom-Raster „Linienraster zeichnen“ anklicken 
 
Zeichenprogramm > Grundeinstellungen > Optionen: „an Raster ausrichten“ anklicken 
 

 
 



 

 

3.21 dynamische Sichtlinien 
 
Funktioniert nur zwischen Fahrzeugen, nicht bei MBS (Multibodysystem) 
 
Fahrzeug > Sichtlinien          " + " drücken 
 

   
 
Pkw: Sitz ist etwa 0,4 m hinter dem Schwerpunkt, d. h. x = - 0,4 m, y = ca. 0,35 m 
Achtung: vorher Schwerpunkt anpassen, siehe Punkt 2.3 
Kann auch im 3D-Fenster angezeigt werden, dann z. B.: z = 0,6 m (über dem Schwerpunkt) 
 

 
 
Sichtlinien-Abstand eingeben: 
 

 
 
 
  

In Grundeinstellungen > Anzeigeoptionen:  
 
Sichtliniendistanz aktivieren,  
Entfernung zwischen den Fahrzeugen bzw. die Länge 
der Sichtlinie wird angezeigt 
 
Sichtlinien können ab der Version 11.1 auch in den 
Diagrammen angezeigt werden, z. B. zur Ermittlung 
des Reaktionsaufforderungspunktes 



 

 

3.22 Fahrzeug-Anzeigeliste / Zwischenpositionen 
 
Über die Fahrzeug-Anzeigeliste können beliebige Zwischenpositionen in der Zeichnung dargestellt und mit 
einem Kommentar versehen werden. 
 
Zuerst Simulation berechnen, gewünschte Zwischenposition anfahren, dann Button “aktuelle Fahrzeugposition 
in die Anzeigeliste aufnehmen“ drücken. Ggf. weitere Zwischenpositionen einfügen. 
 

 
 
Kommentare einfügen: Button „Fahrzeuganzeigeliste bearbeiten“ drücken 
 

 
 
Ergebnis beispielhaft: 
 

 
3.23 Fahrzeugzeichnungen flexibel verwenden 
 
Ab der Version 11.1 können 2D-Dxf´s, 3D-Dxf´s Bitmaps und Punktwolken frei kombiniert werden. 
 



 

 

Fahrzeug > Fahrzeug-Dxf… 
 
Fahrzeug auswählen, ggf. „gültig ab:“ eingeben, 2D- oder 3D-Dxf aktivieren oder deaktivieren 
 

 
 
 
3.24 Zebrastreifen zeichnen / als Linientyp hinterlegen 
 
Zebrastreifen aus Symbolbibliothek einfügen: 

      Aus Symbolbibliothek laden, ist dann gleich skaliert 
 
 
 
Zebrastreifen als Linientyp hinterlegen: 
 
1. Button „Linientypeigenschaften“ anklicken 

2. Button „Neu“ anklicken 

3. Name, Beschreibung und Muster ausfüllen 

   z. B. 0,5 = Breite Markierung, - 0,5 = Zwischenraum 

4. „OK“ 

 

  



 

 

 
 
 

3.25 weiße Bereiche im Bitmap transparent darstellen 
 

   Ansicht > Zoom-Raster…    anklicken 
 

 
 
 
  

5. Linie (gerade oder auch gebogen) zeichnen 

6. Linie markieren, Doppelklick 

7. Linientyp: Zebrastreifen auswählen 

8. Linienbreite vorgeben, z. B. 4,0 m, = Breite Zebrastreifen 

9. ggf. Flächen füllen, Farbe z. B. weiß 

 Bei mehreren Bitmaps: Bitmap auswählen 
 

 Haken bei „Transparenz darstellen/inter“ und „weisse Bereiche 
transparent“ setzen 
 

 Transparenz bei „0 %“ belassen 



 

 

3.26 Bemaßungen in Zeichnung einfügen 
 

 
 
 
3.27 Gefärbte Flächen transparent darstellen 
 

 
 
  

Linie zeichnen, Doppelklick, 
Objekteigenschaften öffnen sich, bei 
Bemaßung Linienstart und Linienende 
auswählen, „Bemaßungstext anzeigen“ 
anklicken, 
 
wenn Pfeillänge proportional zum Bildschirm 
angezeigt werden soll, entsprechendes Feld 
auswählen, zuerst „Übernehmen“ anklicken, 
dann Pfeillänge in % angeben. 

Fläche markieren, Doppelklick auf 
Flächenrand oder Objekteigenschaften:

 
 
Transparenz einstellen 



 

 

3.28 Zeichnung auf das Neigungspolygon verschieben 
 
Im Ribbon „Zeichnen“: Objekte markieren, Button „Zeichnung verschieben / Verschieben auf 
Neigungspolygone ...“ anklicken (geht nicht bei Texten, siehe hierzu nachfolgenden Nummerierungspunkt) 
 

 
 
 
3.29 Beschriftung / Texte über dem Mesh-Modell anzeigen 
 
Problem: 
Beschriftungstexte verschwinden unter dem Mesh-Modell.   
 

 
 

 
 
 
  

Den Text markieren, Karteireiter 
„Zeichnen“, Button „Objekteigenschaften“ 
betätigen 
 

„Vektorfont verwenden“ anklicken 
 
Durch Eingabe der Position Z den Text 
über das Mesh-Modell anheben 
 

Zeichnung ist dann z. B. beim Mesh-
Modell nur teilweise erkennbar.  
 
Abhilfe: Zeichnung einige cm nach oben 
verschieben 



 

 

3.30 Bildschirminhalt in besserer Auflösung kopieren 
 

                        
 

  
 
 

  

Zum Kopieren nebensehenden Button 
betätigen, wenn zusätzlich Taste „Strg“ gedrückt 
wird, erfolgt das Kopieren in höherer Auflösung 

Datei \ Grundeinstellung \ Anzeigeoptionen \ 
Graphik \ Skalierung beim Kopieren 200 %, 
max. 400 % möglich 



 

 

3.31 Innenraumdarstellung aus 360 Grad-Foto 
 

 
 
Für die Fahrersicht ist dann ein 3D-Modell nicht erforderlich, und verursacht lediglich Störungen durch 
überlagerten Fensterausschnitt. Das 3D-Modell kann wie folgt im 3D-Fenster deaktiviert werden: 

    
 
Der Standard-Kastenrahmen wird dennoch angezeigt, kann eliminiert werden, indem die Höhen-Werte für die 
Karosserieform auf Null gesetzt werden. 
 

 
3.32 Punktwolke skalieren 
 
Die Punktwolke (*.e57) ins PC-Crash-Fenster ziehen und markieren 
 

360°-Bild mit 360°-Kamera erstellen, abspeichern 
als *.png-Datei 
 
Fenster in diesem Bild transparent darstellen, 
hierzu z. B. das Fotobearbeitungsprogramm Gimp 
verwenden: 
 
Fenster markieren, transparent darstellen 



 

 

 
 
Oder: 
Punktwolke markieren und im Zeichenprogramm (Button „Zeichnen“) vergrößern / verkleinern 
 
 
3.33 Schnelleres Arbeiten mit der Punktwolke  
 

- Punktwolke triangulieren,  
- Orthofoto erzeugen,  
- Punktwolke löschen (Triangulation belassen),  
- Orthofoto darüberlegen 

 
Simulationen können dann deutlich schneller durchgeführt werden. 
 
 
  

Den markierten Button „Ausgewähltes 
skalieren“ drücken, beim ersten Klick in die 
Punktwolke erscheint ein Skaliermittelpunkt. 
 
Den Cursor auf den Anfangspunkt einer 
bekannten Strecke setzen, dann den 
Endpunkt der bekannten Strecke anklicken 
 
Dann den Cursor soweit verschieben, bis 
links unten im PC-Crash-Fenster bei Δs die 
passende Wegstrecke angezeigt wird 



 

 

4. Videoanimation erstellen / 3D-Darstellung 
 
4.1   2D-Animation / Grundrissanimation 
 

 
 
 

4.2 Kameraposition speichern 
 

    
 
3D Darstellung > Darstellung > Kamera speichern > Name der Kamera angeben, z. B. Zeuge 1 …  
 
Kameraposition wieder abrufen: im 3D-Fenster z. B. Zeuge 1 auswählen 

 
 
 
  

Einlauf, Stoss und Auslauf berechnen,  
Button „Optionen > 2D Animation 
erstellen…“, dann „Speichern unter“ usw. 
 
Ergibt große Dateien, besser: Kamerahöhe  
z. B. 800 m, Brennweite je nach 
erforderlichem Bildausschnitt 



 

 

4.3 Videoanimation 
 
Zuerst Simulation berechnen, mit Schieberegler auf Startposition zurückfahren (nicht: Button „Neue 
Simulation“, erst dann Animation berechnen 
 

 
 
Kameraposition Fahrersicht: 
3D-Darstellung > Animation > berechnen > speichern > Kamera 
 

   
 
Animation berechnen, Vorschlag: 
50 bis 100 fps (Bilder pro Sekunde) 
 

 
  

Kameraposition relativ zu z. B. „1 
AUDI A3“  
 
„Fahrersicht“ anklicken, Kamera wird 
dann automatisch in das Fahrzeug 
gesetzt (mit Blickrichtung nach vorn) 
 
Wenn Kamera selbst positioniert wird 
(z. B. Lkw oder andere Blickrichtung) 

 „Fahrersicht“ nicht anklicken, 
sonst wird gewählte Position wieder 
auf den Standardwert verschoben 
 
Verschieben Kamera + Alt-Taste:  
= feine Schritte 

 

Daten und Zeit einblenden: 
3D-Fenster: Darstellung > Status einblenden 
 

Animationsabmessungen 
werden aus dem 3D-Fenster 
übernommen, wenn der 
entsprechende Haken in den 
Anzeige-Optionen gesetzt ist. 
 
Ansonsten Vorschlag: 
x=1200 
y=600 
 



 

 

Vorschlag: 
Komprimierungsprogramm: „Microsoft Video 1“ 
Komprimierungsqualität: „100%“, ergibt große Dateien, dann anschließend verkleinern 
 
Es liegt dann ein *.avi-File vor. 
 
 
Dateien verkleinern: 
mit Freeware z. B. „VLC media player“ (der ist ohnehin gut) in das Format *.mp4 umwandeln: 
 
VLC media player öffnen: 
 

 
 
 
 
 
 
 
 
 

 

Medien > Konvertieren/Speichern > Datei > 
Hinzufügen, hier können auch mehrere 
*.avi-Files ausgewählt werden, dann Pfeil 
neben „Konvertieren / Speichern“ drücken > 
„Konvertieren“ 

 

Beim Abspielen der mp4-Dateien über den 
VLC-Media-Player fehlen des Öfteren 
einige Sekunden am Anfang oder auch am 
Ende der Animationen. Bei anderen 
Playern, z. B. dem Windows Media Player, 
tritt dieses „Phänomen“ nicht auf. In der 
jeweiligen mp4-Datei ist somit die 
vollständige Animation enthalten. 



 

 

 
 
3D-Dxf verschwindet während der Berechnung: 
Wenn eine Animation aus Fahrersicht berechnet wird, kann es vereinzelt vorkommen, dass das andere 
Fahrzeug (das 3D-Dxf) im Video plötzlich verschwindet. Ursache: Textur der Frontscheibe.  
 
Notlösung:  
Kamera vor die Scheibe setzen, ggf. Fahrzeug um die gleiche Wegstrecke nach hinten verschieben, damit die 
Sichtposition wieder stimmt (das 3D-Dxf des Kamera-Fahrzeuges löschen, hilft nicht). 
 
Bessere Darstellung im Mesh-Modell: 

 
Im 3D-Fenster: Darstellung > Anzeige Optionen 
 
 
 
 
 
 

 
„Darstellung als Drahtmodell“ einschalten 
 
„Fahrzeuge“ ausschalten 
 
Das oder die Fahrzeuge werden dann als Gittermodell 
dargestellt 
 
 
 
 
 
 
 
 
 
 

 
Zeitlupe in Animation: 

 

 

Öffnen z. B. mit dem 
Windows Media 
Player: 
 
Rechtsklick auf die 
Datei, dann „Windows 
Media Player“ 
auswählen 



 

 

   
 
Nicken/Wanken berücksichtigen: 
Kamera > 3D Darstellung > Anzeige Optionen        relative Kameraposition anklicken, dann … anklicken 

  
 

 
 
Gutachten-Anlage: 
.avi-Film auf Bildbearbeitungsprogramm überspielen, Einzelbilder als Film ausdrucken 
 
  



 

 

 
4.4 Ansichtsfenster zusätzlich / Spiegelsicht 
 

 
 
 

 
 
 

 
 
 
bei Spiegelsicht: das Ansichtsfenster anklicken (Bezeichnung ist der vergebene Name, z. B. „Spiegel“ in der 
Kopfzeile des 3D-Fensters links)  
 
> Ansichtsfenster > Einstellungen „Reflexion“ aktivieren, Kamera zeigt dann nach vorn!  

In der 3D-Darstellung: 
> Ansichtsfenster > Hinzufügen 
 
Dann erscheint ein 
Ansichtsfenster 

In der 3D-Darstellung: 
Zuerst Ansichtsfenster anklicken, dann 
> Ansichtsfenster > Bewegen/Größe ändern 
 
Ansichtsfenster anpassen und verschieben (bei 
Spiegelsicht: vorher Fahrzeuge in Startposition 
bringen) 

Namen vergeben, z. B. „Spiegel“ 



 

 

Geht nicht: Richtung der Kamera im 2D-Fenster nach hinten drehen, dann ist es keine Spiegelsicht, links und 
rechts im Spiegel ist unzutreffend 
 
Dann in´s 2D-Fenster wechseln, Kamera positionieren 
 

 
 
> Kamerasymbol > Brennweite bei Spiegelsicht ca. 28 – 35 mm 
 

 

 
 
Es können auch mehrere Außenspiegel oder weitere Ansichtsfenster eingefügt werden. 
 
 
 

> Darstellung > „Rel. Kameraposition…“  
Einstellungen für einen Spiegel wie nebenstehend, 
„Nicken/Wanken“ anklicken (sonst schwankt der 
Spiegel leicht in der Animation) 
 
Diese Einstellung auch beim Fahrzeug (= Viewport) 
verwenden 

> Darstellung > „Kamera speichern…“  
Einstellungen für einen Spiegel wie nebenstehend, 
ggf. Nicken/Wanken anklicken 
 
Diese Einstellung auch beim Fahrzeug (= Viewport) 
verwenden 

Wenn sich bei einer Kurvenfahrt des Fahrzeuges 
der Spiegel verschiebt, hat sich offenbar 
automatisch der Haken bei „konstante Blickrichtung“ 
aktiviert, dann diesen wieder rausnehmen! 
 



 

 

  



 

 

4.5 Sichteinschränkung A-Säule / Augenabstand / Ansichtsfenster zusätzlich 
 
Ansichtsfenster einfügen: „linkes Auge“ 
Ansichtsfenster einfügen: „rechtes Auge“, beide gleiche Größe 
Werte aus Kameraposition „Fahrersicht“ linkes Auge übertragen, dann bei rechtem Auge x + 10 cm (bezogen 
auf das allgemeine Koordinatensystem 
 
 

4.6 Hintergrundbild für 3D-Simulation verwenden / Kameraposition optimieren 
 
- Überlagerung mit Draufsicht (Google-Earth, On-Geo) ist möglich 
- Perspektive im 3D-Fenster etwa wie auf dem Hintergrundbild 
- 3D-Darstellung öffnen 
- Hintergrund > Bitmap öffnen 
 
 
 
 
 

 
Darstellung > Anzeigeoptionen: 
 
„Himmel zeichnen“ ausschalten 
„Wiese zeichnen“ ausschalten 
„Bitmap aus 2D Fenster zeichnen“ ausschalten 
 
 
 
 
 
 
 
 
 
 
 

Perspektive im 3D-Fenster an das Hintergrundbild anpassen, hierzu ggf. Transparenz der Draufsicht erhöhen 
 
Hintergrundbild in 3D-Darstellung verdrehen:  

 
4.7 Bildsequenzen erstellen, aus 3D-Fenster 
 
Simulation rechnen, Animation berechnen,  

       
 
 
 
 

 

 

 



 

 

 
 
 
 
 
 

 
 
 
 
 
 
 

 
 
 

4.8 Mast soll umfallen 
 
z. B. Lichtmast soll nach der Kollision in der 3D-Darstellung umfallen:  'Tree laden, wie folgt: 
Button "DAT"            Verzeichnis PCCrashXX > Custom vehicles > Objects > Tree > Tree.dat 
Oder: Explorer-Toolbar > Fahrzeugdaten > Objects > Tree > Tree.dat 
 

 
In Fahrzeug > Fahrzeugdaten:            Abmessungen einstellen, z. B. wie folgt: 
 

Dateiname: *.jpg 
 
Speichern 

 Auflösung z. B. 1000 x 600  
 Bilder pro Sekunde z. B. 1 fps bis 5 fps 
 Start 
 
Die Einzelbilder sind dann im Ablageverzeichnis, im 
obigen Beispiel in „PC-Crash-GA“ gespeichert  

 

Eine Sequenz für Tree eingeben,  
z. B. Bremsen (nach "Start") 
 

 



 

 

 
 
 
4.9 Ampelphasen für 3D-Simulation verwenden 
 
Variante 1, manuelle Erstellung einer Ampel: 
auf der Homepage von DSD ist ein Tutorial hinterlegt, bei dem die Vorgehensweise als kurzer Film abgespielt 
werden kann. Der Signalwechsel wird dann in der 3D-Simulation dargestellt:   www.dsd.at  
 
Variante 2, Einfügen aus Symbolleiste: 
Ampelobjekt aus Symbolleiste einfügen Doppelklickauf eingefügte Ampel           Phasenplan 

  
 
Phasenplan bearbeiten z. B. roten Balken (Block) verschieben oder besser:  
 rechte Maustaste auf Balken > Eigenschaften             Werte einstellen 
 andere Blöcke bearbeiten, ggf. löschen oder neue einfügen 

 
 
Phasensteuerung > TimeLine Eigenschaften: Zeitachse einstellen (=gesamte Zeitdauer eines 
Ampelphasenumlaufes, z. B. 80 s) 
 



 

 

 
 
Kleinen Schieberegler oben ganz nach rechts 
 

 
 
Diagramm in die Breite ziehen (wegen besserer Auflösung), dann Zeitlinie mit Schieberegler auf Startposition 
in der Simulation stellen,  
z. B. Kollision = Startposition, Ampel 4,6 s vor grün überfahren, vorher 3 s Wartezeit bei grün (wegen anderen 
Fahrzeugen im Kreuzungsbereich), somit hat Ampel 7,6 s vor der Kollision auf grün umgeschaltet, auf der 
Zeitachse im genannten Beispiel somit bei 43,6 s 
 

 
 
andere Ampel synchronisieren, indem Zeitlinie ebenfalls auf 43,6 s gestellt wird 
 

 
 
Fertig. 
 
  



 

 

4.10 Lichtquellen (z. B. Blinker oder Bremslicht) einfügen 
 
Blinker einfügen:                          Fahrzeuge auf Startpos. stellen („neue Simulation“) 
 

 
 
 
 
> „Farbe Wiese“ auf grau umstellen 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Lichtquelle,  
z. B. Name „2“ anklicken 
- Lichttyp: Spotlicht 
- Farbe: gelb oder hellorange 
- relativ zu: „Fahrzeug auswählen“ 
- Lichtquelle hinter Kameraposition: aus 
- „Standort-Cursor“ zum Blinklicht  
   im 2D-Fenster (nicht im 3D-Fenster)  
   schieben 
- Lage des Blinklichts mit „Standort-

Parametern“ nachjustieren 
 
 
 

 

Zunächst „Wiese zeichnen“ aktivieren, 
> Anzeige Optionen  

3D-Darstellung: 
Draufsicht einstellen (y-x) 
Lichtquelle anklicken 



 

 

 
 
 
 
 
  

Blinkfrequenz eingeben: 
- Diagramm-Symbol anklicken 
- mehrere Zeiten „einfügen“ 
- kontrollieren im 3D-Fenster 



 

 

5. ReconData 
 
Öffnen über  

 
 
 
5.1 Bilder mit Maßstab: 
 

 
 
 

5.2 Versuchsdatenbank 
 
Hier können Filter gesetzt werden, z. B. EES zwischen 20 und 25 km/h:  
 

 
 
 
 
 
 

Fahrzeug auswählen, Bild anklicken 

Auf Filtersymbol klicken 
 
Gewünschte Untergrenze (greater than) 
und Obergrenze (less than) eingeben 
 
„Filter“ anklicken 
 
 
 
Geht auch bei den anderen Spalten 



 

 

5.3 EES-Katalog: 
 

 
 

 
 
 

  

Hersteller eingeben, ggf. Modell auswählen, 
ID-Nr. anklicken, z. B. „19“, dann erscheinen 
die Daten mit der statistischen Auswertung. 
 
Es handelt sich um EES-Einschätzungen von 
Umfragen unter Sachverständigen, somit 
nicht um Ergebnisse aus Crashversuchen. 
Die statistischen Daten einschließlich der 
Auswertung sind dargestellt.  
 

Bei jedem neuen Aufruf „F5“ drücken, dann 
wird das Statistik-Diagramm („Verteilung“) 
aktualisiert, sonst wird Verteilung von vorher 
aufgerufenem Fahrzeug übernommen!  
 



 

 

6. PC-Rect 
 
Objektivkorrektur durchführen, siehe Handbuch  
 
Jedoch:  Testfoto (Pattern, Schachbrettmuster) zum Bestimmen der Objektivkorrektur deutlich abdunkeln, 
sonst werden vom Programm die Schnittpunkte nicht gefunden 
 
z. B. wie in folgender Darstellung mit Fotobearbeitungsprogramm abdunkeln 
 

 
 
Dann Kantenlänge eingeben, Objektivkorrektur bestimmen, Speicherort wählen, abspeichern  
 
 
(z. B. GA-Verwaltung_Buero > PCCrashGutachten > Objektivkorrektur > GoPro Hero3-Silver Edition f 2.5 
mm5MP) 
 



 

 

 
 
 
  



 

 

7. Auszug aus dem PC-Crash-Handbuch 
 
7.1 3D-Sichtbereich darstellen 
 

1. Öffnen Sie den DXF-Dialog über <Fahrzeug> <Fahrzeug-DXF>  , wählen Sie im Fahrzeugfenster das 
gewünschte Fahrzeug und drücken Sie die Taste Neu , um eine leereDXF-Zeichnung für das Fahrzeug zu 
erhalten. Deaktivieren Sie die Option “Fahrzeugfarbe übernehmen”. 

2. Aktivieren Sie danach die Option “Zeichnung bearbeiten”. 

3. Zeichnen Sie über den Menüpunkt <Zeichnen> <Objekte> <Dreiecksfächer >  den gewünschten 
Sichtbereich ein. Mit Hilfe der verschiedenen Ansichten , können die Punkte des Fächers in 
alle Richtungen verschoben werden, bis die Platzierung zum Sichtbereich passt. 

 

4. Über das Eigenschaftsfenster kann der Fächer in Bezug auf Farbe und Transparenz angepasst werden. 

5. Bestätigen Sie den DXF-Dialog mit OK . Der Dreiecksfächer ist nun mit dem Fahrzeug verknüpft. Zur 
Ansicht im 3D Fenster beachten Sie, ob die Option 3D Ansicht im DXF-Dialog aktiviert ist (siehe auch 
voriges Kapitel). 

 

 


